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Capitulo 1. Introducao ao Aplicativo de Cenario da Loja de
Varejo do iSeries

O pacote de cenarios é um aplicativo de amostra desenvolvido utilizando o IBM
WebSphere Development Studio Client para iSeries, a tecnologia com base no
Eclipse para o servidor iSeries. Os cendrios foram criados para desenvolvedores
que desejam utilizar um servidor iSeries para:

* Desenvolvimento Java
* Desenvolvimento para a Web

* Gerenciamento e transformagao de c6digo RPG em aplicativos da Web

O aplicativo consiste em dois arquivos .savf que sdo restaurados no servidor
iSeries e em cinco arquivos .zip que sdo importados para o produto cliente. Eles
formam uma série de paginas da Web com URLs para diversos pontos no
processo.

Nota importante: Verifique a pagina de suporte para obter todos os pacotes de
servico, PTFs e outras informacdes:
libm.com /software/awdtools/wdt400/support/|

Estes cendrios o guiam por diversas partes do produto, com énfase em
componentes especificos do iSeries, como:

* A IBM WebFacing Tool
* Servicos Web

¢ Ferramentas de desenvolvimento da Web para iSeries (incluindo o assistente
Web Interaction e o assistente de Chamada de Programa)

* Ferramentas de desenvolvimento Java para iSeries
* O IBM Toolbox para Java

Os cenarios ilustram a situagdo de duas empresas, um fornecedor atacadista e uma
loja varejista de roupas, que negociam entre si e utilizam servidores iSeries para
logica de negocios e dados. As duas empresas costumavam comunicar-se por
e-mail, telefone e fax, para verificar o inventario, enviar pedidos e acompanhar o
atendimento dos pedidos. Agora, pretendem utilizar a Web para executar suas
transacdes de negdécios comuns.

O varejista deseja um site na Web que:
* Os clientes possam utilizar para comprar produtos

* Os funcionarios possam utilizar para solicitar inventario ao atacadista

O fornecedor atacadista deseja:
* Receber pedidos do varejista on-line, para acompanhamento
* Atender vérios possiveis clientes

Neste cenario, vocé assumira o papel de um consultor de programacao para as
duas empresas, ajudando-as a colocar seus negdcios na Web.

O aplicativo tem dois pontos de entrada diferentes, com base no tipo de usuario.
Como cliente, sua primeira etapa é visualizar os produtos que a loja tem para
oferecer, neste caso, roupas casuais. Para fazer uma compra, vocé pode clicar em


http://www.ibm.com/software/awdtools/wdt400/support/

um link para acessar uma tela de pedido. Depois de fazer o pedido, serd gerada
uma pégina de resumo e vocé podera continuar comprando, cancelar o pedido ou
enviar o pedido.

Como administrador, vocé tem um ID do usudrio seguro para o aplicativo,
exigindo a definicdo da politica de seguranca do aplicativo durante a
implementagdo. Seu ponto de entrada é uma tela de login, na qual é possivel ver
seus pedidos e o inventério e comprar do fornecedor atacadista. E possivel
selecionar itens, verificar o preco de atacado atual e solicitar o tamanho e a
quantidade desejados. O aplicativo verifica se o atacadista tem o tamanho e a
quantidade desejados e confirma o pedido ou o avisa que ndo podera atender o
pedido agora.

Abaixo da superficie do aplicativo, estdo ocorrendo vérias a¢des nas diversas
partes do produto. A tabela a seguir ilustra o processo e o componente do produto
responsaveis por cada parte do aplicativo. Prossiga com as informacoes detalhadas
sobre como executar cada tarefa.

Tabela 1.
Tarefas do Tarefas do Aplicativo |Processo Subjacente
Aplicativo do do Administrador
Cliente
Exibir precos de Utilize um programa RPG do iSeries para
produtos criar um servigo da Web e utilize as
ferramentas de desenvolvimento da Web para
visualizar e exibir os precos.
Fazer um pedido Utilize servlets e arquivos JSP juntamente
da loja com as ferramentas de desenvolvimento Java
do iSeries, ferramentas de desenvolvimento
da Web do iSeries e o IBM Toolbox para Java
para acessar e visualizar o inventdrio em um
servidor iSeries e para fazer pedidos e
mostrar o resumo de uma compra.
Visualizar inventario Utilize a IBM WebFacing Tool para converter
um programa RPG existente em um
aplicativo da Web e as ferramentas de
desenvolvimento da Web para personalizar a
pégina da Web.
Fazer um pedido para |Crie um servico da Web que seja chamado
o fornecedor atacadista | quando vocé clicar no botdo Purchase.
com o ID e quantidade
da mercadoria.
Visualizar a Visualizar a pagina da | Utilize ferramentas de desenvolvimento da
pégina da Web da | Web para inventario de | Web para iSeries para criar as duas home
loja. pedidos. pages.

Cenarios com Base em Projetos

O aplicativo de cendrios do iSeries é composto de cinco projetos, denominados
5V000501, SV000514, SV000618, SV001585 e SV001586. Este guia contém instrugdes
de como executar o aplicativo compactado. O guia também contém mdédulos passo
a passo e modulos avangados, mostrando como vocé mesmo pode construir dos
diversos projetos. Os médulos passo a passo sdo destinados a desenvolvedores
com pouca experiéncia no desenvolvimento de aplicativos e Development Studio
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Client. Os médulos avangados foram criados para desenvolvedores com
experiéncia em desenvolvimento de aplicativos e mais familiarizados com o
Development Studio Client.

Nota: Apesar de existirem cinco projetos, os médulos sdo apenas quatro, pois os
projetos SV001586 e SV000514 sdao moédulos de Servigos da Web combinados.

Este cenario estd na forma de cinco projetos:

Projeto SV000501: Crie um projeto da Web para visualizar pedidos pendentes,
inventario e detalhes do produto — Este projeto é criado com as ferramentas de
desenvolvimento da Web do iSeries e a IBM WebFacing Tool e foi desenvolvido
para programadores de RPG com conhecimento limitado de desenvolvimento de
aplicativos da Web e desejam utilizar a IBM WebFacing Tool para colocar seus
aplicativos de RPG na Web.

Projeto SV001585: Crie c6digo HTML, servlets e arquivos JSP que registram
pedidos de clientes em um servidor iSeries — Este projeto utiliza a IBM Toolbox
para as classes Java SQL e JDBC, o bean RecordlOManager das ferramentas de
desenvolvimento Java do iSeries e o assistente de chamada do Programa iSeries.
Esses elementos mostram diversas formas de acessar e manipular dados e
programas existentes no servidor do iSeries. Este projeto foi desenvolvido para
programadores Java e desenvolvedores de aplicativos da Web que desejam
desenvolver paginas da Web para acessar dados e cédigos do iSeries. Além disso, é
necessario ter conhecimentos praticos de gerenciamento do servidor iSeries e de
programacado RPG.

Projeto SV000514: Crie um servico da Web do iSeries para fornecer precos de
produtos — O assistente de Servigos da Web utiliza um bean Java gerado pelo
assistente iSeries Program Call para chamar um ou mais procedimentos do
programa no servidor iSeries e transmitir as informacdes de volta para um
navegador. Este projeto foi desenvolvido para programadores de RPG que desejam
utilizar os Servicos da Web para criar aplicativos modulares independentes que
possam ser descritos, publicados, localizados e chamados na World Wide Web.

Projeto SV001586: Crie um servico da Web para fazer pedidos ao fornecedor
atacadista por meio de um servidor iSeries — O servico da Web aceita um ID de
mercadoria e a quantidade necessaria e, em seguida, faz o pedido para o
atacadista. Este projeto € um componente do SV000514, desenvolvido para
programadores de RPG que desejam criar servigos da Web.

Projeto SV000618: Criar um projeto da Web para obter interface com o
formulario de pedido, o formulario de inventario e a ordem de compra gerados
pelo a IBM WebFacing Tool —Este projeto requer as ferramentas de
desenvolvimento da Web do iSeries e envolve a criagdo de arquivos HTML e JSP
para utilizar e conectar os servigos da Web desenvolvidos nos projetos SV000514 e
5V001586. O projeto foi criado para desenvolvedores que desejam trabalhar com o
Servigos da Web e tém conhecimentos de programagdo RPG e Java.

Capitulo 1. Introdugao ao Aplicativo de Cenario da Loja de Varejo do iSeries 3
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Capitulo 2. Conceitos Tecnolégicos

Para trabalhar com o aplicativo de cenarios, é necessario estar familiarizado com
diversos conceitos tecnoldgicos, principalmente se ndo tiver experiéncia com
desenvolvimento de aplicativos da Web. A seguir é fornecida uma pequena lista de
alguns dos conceitos que serdo encontrados no aplicativo.

Arquivo EAR (Enterprise Archive)

Um arquivo EAR é um arquivo JAR (Java Archive) padrdo, com extensdo .ear.
Esses arquivos podem conter varios projetos da Web e podem ser utilizados para
compactar e implementar aplicativos da Web no WAS (WebSphere Administrative
Server). Nota: Na versdao GUI da ferramenta de implementagdo de aplicativos J2EE
SDK, primeiro vocé cria um arquivo EAR e depois adiciona os arquivos JAR e
WAR (Web Archive) no arquivo EAR. No entanto, se vocé utilizar as ferramentas
de compactagdo da linha de comando, criard primeiro os arquivos JAR e WAR e
depois o arquivo EAR.

IBM WebFacing Tool

A WebFacing Tool da IBM converte as interfaces 5250 existentes em interfaces
gréaficas com o usudrio com base no navegador. Com pouca ou nenhuma
modificagdo em seus aplicativos originais do iSeries, vocé pode estender o uso de
seus programas para a Internet ou uma intranet.

Arquivo JAR (Java Archive)

Um arquivo JAR é um pacote compactado de arquivos Java, semelhante a um
arquivo .zip. Ele contém os arquivos de classe, de imagem e de som para um
applet Java, reunidos em um mesmo arquivo e compactados para facilitar o
download para o navegador.

JSP (Java Server Pages)

JSPs fornecem a capacidade de exibir contetido dindmico em paginas HTML
estaticas. Gravados em Java, os JSPs sdo independentes do servidor e da
plataforma. Separando com eficiéncia a apresentacdo na Web do contetido da Web,
JSPs podem ajudar desenvolvedores que precisem alterar rapidamente o design e a
exibi¢do de suas paginas da Web.

Bean de Chamada de Programa

Estes sdo os beans Java gerados pelo assistente de Chamada de Programa. Um tipo
é um bean Java regular utilizado por aplicativos Java. O outro tipo também pode
ser utilizado pelo assistente de servicos da Web para criar um servico da Web.

Assistente de Chamada de Programa

O assistente de Chamada de Programa ajuda a criar os beans Java e o arquivo
PCML associado, necessarios para chamar um programa ou procedimento do
iSeries. O assistente solicita as informacdes referentes a objetos do programa ou do
programa de servigos, juntamente com os parametros dos objetos e, em seguida,
cria os beans Java desejados (e o arquivo PCML).



RPG (Report Program Generator)

Uma linguagem de programacado de procedimentos utilizada por programadores
do iSeries. A linguagem RPG pode ser utilizada para criar aplicativos de negdcios
como programas de fatura e programas de entrada de pedidos. A versdo mais
recente, ILE RPG IV, expande os recursos da linguagem RPG, ao mesmo tempo
que oferece suporte a experiéncia do programador com versdes anteriores.

Servlet

Programas no lado do servidor, escritos em Java, executados em servidores
ativados para Java ou servidores de aplicativos como IBM WebSphere Application
Servers. Os servlets executam tarefas especificadas pelo servidor, como resposta a
pedidos gerando uma resposta HTML. Por exemplo, os servlets podem ser
utilizados em um aplicativo de banco on-line para responder ao usudrio enquanto
envia dados para o servidor.

Componentes da Web

Os Componentes da Web podem ser utilizados para definir objetos do iSeries como
campos de entrada de dados e botdes de comando, que podem trocar informacgdes
entre programas servidores do iSeries e a pagina da Web. Os desenvolvedores
podem utilizar Componentes da Web para capturar eventos do usuério, como
verificacdo da sintaxe de campos de entrada e cliques em botdes.

Assistente de Interacio com a Web

Esse assistente faz parte das ferramentas de desenvolvimento da Web do iSeries.
Ele cria e gerencia as interacdes entre programas ILE e paginas da Web. O
assistente controla onde as mensagens de entrada, de saida e de erro sdo exibidas e
direciona os dados dos campos de entrada e de saida para os programas ILE. O
assistente de Interacdo com a Web também pode ser utilizado para mapear
mensagens de erro para a drea na qual o erro ocorreu, para que o usudrio possa
identificar facilmente a origem do erro.

Servicos da Web

Os servigos da Web sdo aplicativos independentes, desenvolvidos e implementados
para uso na Internet. Eles sdo criados com padroes abertos, como SOAP, WSDL e
XML. Existem diversas situagdes de negécios com as quais é possivel utilizar um
servico da Web, inclusive em um sistema de gerenciamento de inventario no qual
os clientes podem verificar pela Internet o nivel do inventério ou, para
acompanhar um pedido diretamente do fornecedor.

WSDL (Web Services Definition Language)

WSDL é uma linguagem com base em XML que define a interface de um servigo
da Web. A WSDL entende um servico da Web e gerencia o fluxo de informagdes
entre esse servico e o programa do servidor. Por exemplo, um desenvolvedor
utilizaria WSDL para criar uma interface para um site na Web que mostre cota¢oes
de estoque atualizadas.

WebSphere Studio Workbench

O IBM WebSphere Development Studio Client para iSeries é criado no WebSphere
Studio Workbench, a implementagao IBM da plataforma Eclipse. O Workbench
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extensivel e universal integra todas as ferramentas necessarias para construir e
manter aplicativos. Os desenvolvedores podem utilizar o Development Studio
Client para incorporar novos objetos no ambiente de desenvolvimento utilizando
plug-ins e podem adicionar de forma integrada arquivos Java, gréaficos, video, etc.

Capitulo 2. Conceitos Tecnolégicos 7



8  Aplicativo de Cendrio da Loja de Varejo do iSeries



Capitulo 3. Executando o Cenario

Os aplicativos Wholesale e Retail store podem ser executados dentro do Workbench
do Development Studio Client ou no WebSphere Application Server para qualquer
plataforma, inclusive a do iSeries. Consulte [Capitulo 1, “Introducao ao Aplicativo|

lde Cenario da Loja de Varejo do iSeries”, na pagina 1 para obter uma visdo geral

dos aplicativos.

Ao final deste capitulo, vocé tera aprendido a:

Restaurar os arquivos de amostra e objetos Development Studio Client para o
servidor iSeries

Criar projetos da Web e um projeto WebFacing para conter os arquivos

Importar os arquivos restaurados do servidor iSeries para o Development Studio
Client

Configurar o WAS (WebSphere Application Server)

Configurar o projeto WebFacing

Executar o aplicativo como cliente no Ambiente de Teste do WebSphere
Executar o aplicativo como administrador no WebSphere Test Environment
Configurar o WebSphere Application Server

Aplicar seguranca na pagina do administrador

Criar arquivo EAR para implementacdo externa do WAS

Implementar o aplicativo no WAS

Executar o aplicativo no WAS

Antes de Comecar

Para testar os aplicativos a partir do o Ambiente de Trabalho, é necessario
assegurar que:

Vocé tem uma V5R1 ou posterior no servidor iSeries

Possuir os PTFs do WebFacing mais recentes aplicados. Consulte nossa pagina
de suporte para PTFs:
|http: / /www.ibm.com /software /awdtools/wdt400 /support/ |

Vocé tem acesso NET USE ao servidor iSeries

Instalando os Arquivos de Amostra

Para utilizar o aplicativo de cendrios do iSeries, é necessario trabalhar com os
seguintes arquivos:

Wholesale.savf
Retailstor.savf
Qdtssfl.savf
5V000501.zip
5V000514.zip
SV000618.zip
5V001585.zip
S5V001586.zip


http://www.ibm.com/software/awdtools/wdt400/support/

Os arquivos .savf contém dados e programas RPG do iSeries e os arquivos .zip
contém os aplicativos da Web que interagem com os programas do iSeries para
manipular os dados do iSeries. Primeiramente, é necessério restaurar os arquivos
.savf para o servidor iSeries e, em seguida, vocé podera importar os arquivos .zip
para o Development Studio Client e executar o aplicativo no workbench.

Restaurando os Arquivos .savf

Para trabalhar com as amostras deste guia, € necessdrio restaurar as bibliotecas
WHOLESALE e RETAILSTOR para o servidor iSeries. Vocé deve fazer isso mesmo
se ja tiver restaurado as bibliotecas para releases anteriores do produto, porque
seus contetdos sdo diferentes.

Nota: Os arquivos .savf utilizados para instalar a biblioteca de amostra sdo para
uso com a V5R1 ou posterior do servidor iSeries. Para este cendrio, as duas
bibliotecas sdo restauradas para o mesmo servidor iSeries, mas se vocé
estivesse desenvolvendo este aplicativo para uma empresa real, restauraria
as duas bibliotecas para dois servidor iSeries diferentes. A biblioteca
WHOLESALE seria restaurada para o servidor iSeries que fornece os
servicos da Web e a RETAILSTOR, para o servidor iSeries que pertence a
loja varejista.

Para restaurar o arquivo Wholesale.savf:

1. Efetue logon no servidor iSeries por meio de um emulador de tela verde.

a. Crie uma biblioteca para conter os arquivos de gravagdo. Para criar uma
nova biblioteca no emulador, insira CRTLIB.

b. Nomeie a biblioteca como SCENARIO.

C. Avance para a proxima linha com a tecla Tab, especifique *TEST como tipo
de biblioteca e pressione Enter para salvar as alteragdes.

d. Crie dois arquivos de gravagao utilizando o comando CRTSAVF,
pressionando Enter entre as duas linhas:

CRTSAVF FILE(SCENARIO/WHOLESALE)
CRTSAVF FILE(SCENARIO/RETAILSTOR)

Essas linhas especificam que vocé deseja criar arquivos de grava¢do na
biblioteca Scenario.

2. Na estagdo de trabalho, abra uma janela do Prompt de Comandos.

a. E necessario alterar para o diretério no qual os arquivos .savf estio. Por
padrdo, vocé deve inserir cd c:\wdsc\wdscsampl. Se vocé instalou o produto
em uma unidade diferente ou escolheu nao utilizar "wdsc” como o diretério
inicial para o Development Studio Client, altere o diretério wdscsampl no
local correto em que o produto foi instalado.

b. Na linha de comandos, insira: ftp hostname, em que hostname é o nome do
servidor iSeries, por exemplo, PROD400.

o

Insira o ID do usudrio e senha para o servidor iSeries.

o

Na linha de comandos, insira cd /qsys.lib/scenario.1ib para alternar para
a biblioteca Scenario.

e. Insira as seguintes linhas:

bin

put WHOLESALE.savf WHOLESALE.savf

put RETAILSTOR.savf RETAILSTOR.savf
quit

Essas linhas (antes de sair) especificam que vocé deseja transferir os
arquivos de gravagdo do sistema local para o servidor iSeries.
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3. De volta ao console do iSeries, restaure a biblioteca Wholesale:
a. Insira RSTLIB e pressione F4 para definir como deseja restaurar a biblioteca.
b. No campo Saved Library, insira WHOLESALE e pressione a tecla Tab.
c. No campo Device, insira *savf e pressione a tecla Tab.
d

Pressione Enter no préximo campo para exibir valores adicionais e avance
para o campo Save file com a tecla Tab.

e. Insira WHOLESALE no campo Save file e pressione a tecla Tab.
f. No campo Library, exclua o valor existente e insira scenario.

0. Pressione Enter para restaurar a biblioteca WHOLESALE para o servidor
iSeries.

4. Repita esse procedimento para o arquivo Retailstor.savf:
a. Insira RSTLIB e pressione F4 para definir como deseja restaurar a biblioteca.
b. No campo Saved Library, insira RETAILSTOR e pressione a tecla Tab.
c. No campo Device, insira *savf e pressione a tecla Tab.
d

Pressione Enter no proximo campo para exibir valores adicionais e avance
para o campo Save file com a tecla Tab.

o

Insira RETAILSTOR no campo Save file e pressione a tecla Tab.
f. No campo Library, exclua o valor existente e insira scenario.

0. Pressione Enter para salvar sua agdo e restaurar a biblioteca RETAILSTOR
para o servidor iSeries.

Modificando a Lista de Bibliotecas

Apesar de vocé ter restaurado as bibliotecas RETAILSTOR e WHOLESALE para o
servidor iSeries, é necessario assegurar que elas estdo na lista de bibliotecas
utilizada ao se conectar. Caso contrario, os aplicativos da Web podem nao
conseguir localizar as bibliotecas e podem ocorrer problemas durante a execugdo
ou compilacdo dos aplicativos. E necesséario também certificar-se de que a
biblioteca QGPL esteja na lista de bibliotecas.

Para fazer isso, é necessario atualizar a descri¢do do job e o perfil do usudrio para
que as alteragdes na lista de bibliotecas sejam permanentes.

Usuadrios diferentes tém formas diferentes de modificar sua lista de bibliotecas, mas
se vocé ndo souber como, este é um exemplo:
1. No servidor iSeries, digite dsp1ib1 e pressione Enter para exibir a lista de
bibliotecas .
2. Verifique se as bibliotecas RETAILSTOR, WHOLESALE e QGPL estdo na lista.
Se estiverem 14, é possivel sair e encerrar sua janela do emulador. Se ndao
estiverem, proceda da seguinte forma:

a. Pressione F12 para cancelar a tela atual.

b. Localize o nome de sua descri¢do do job. Para fazer isso, digite dspusrprf
username e pressione Enter para exibir seu perfil de usudrio, em que
username é o ID utilizado para se conectar ao servidor iSeries. A descrigdo
do job estd em uma das péginas do perfil do usudrio (utilize Page Down).
AO localizar sua descri¢ao de job, anote-a e pressione F12 para sair da tela.

€. Na linha de comandos, digite chgjobd e pressione F4.

d. No campo Job Description, digite o nome da descri¢do do job e pressione
F10 para obter pardmetros adicionais.

e. Pressione page down até a Initial library list.
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f. No campo abaixo Initial library list, vocé vera "+ for more values”. Insira
um sinal de mais e pressione Enter.

0. Na pégina Specify more values, exclua qualquer entrada existente e digite
RETAILSTOR, WHOLESALE, e QGPL, tabulando entre cada valor. E mandatério
inserir as bibliotecas nessa ordem, pois os aplicativos precisam localizar
primeiro a biblioteca RETAILSTOR. Pressione Enter.

h. Pressione Enter novamente, para salvar as alteracdes.

i. Na linha de comandos, digite: chgusrprf e pressione Enter.
j. Digite o nome de usudrio e pressione Enter.

k. Pressione F10 para consultar os parametros adicionais.

|. Pressione page down até a Job description.

m. Se o nome de sua descri¢ao do job nao corresponder a descri¢do do job
localizada com o comando dspusrprf, digite o nome da descri¢do do job
localizada com esse comando e pressione Enter para salvar suas
alteracoes.

Importando e Executando o Aplicativo no Development Studio Client

Cinco arquivos zip se encontram nos arquivos de programas instalados para o
cliente do Delopment Studio, por padrao, no diretério c:\wdsc\wdscsampl. Esses
arquivos sao:

¢ 5V000514.zip

¢ 5V000618.zip

¢ 5V001585.zip

¢ 5V001586.zip

¢ SV000501.zip

Cada um sera importado separadamente para o workbench do Development
Studio Client e a cada um sera atribuido um arquivo EAR (Enterprise Archive)
correspondente. Um arquivo EAR é um arquivo JAR (Java Archive) padrdo, com
extensdo .ear. Eles podem conter vérios projetos da Web e podem ser utilizados
para compactar e implementar aplicativos da Web no WAS (WebSphere
Administrative Server).

Os quatro primeiros arquivos correspondem aos projetos da Web e o quinto
corresponde a um projeto WebFacing. Primeiramente, crie os projetos da Web e
depois, o projeto WebFacing. Em seguida, importe o contetido dos arquivos zip
para os cinco projetos.

Extraindo Arquivos .zip em seu Sistema Local

Antes que seja possivel importar o contetido dos arquivos .zip de cendrio para o
workbench do Development Studio Client, é necessario extrai-los para diretérios
separados, de forma que vocé possa importd-los como sistemas de arquivos, ao
invés de como arquivos .zip.

Nota: Se vocé estiver utilizando um programa que nao seja o WinZip, execute as
tarefas da mesma forma que com esse programa.

1. Em seu sistema local, navegue para c:\wdsc\wdscsampl. O diretério c:\wdsc
pode ser diferente se vocé escolher instalar em uma unidade diferente ou em
uma pasta base diferente. Nesse caso, navegue até esse diretério e, em seguida,
localize \wdscsampl.

2. Dé um clique duplo no arquivo .zip a seguir: SV000501.zip.
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Clique no botao Extract e navegue para a mesma pasta em que os arquivos zip
se encontram, por padrdo, c:\wdsc\wdscsampl.

Selecione o botdo de opgdes All Files e, em seguida, clique em Extract.

Se vocé observar no diretério wdscsampl, vocé verd que uma pasta SV000501
foi criada, com todos os arquivos necessérios dentro.

Agora que todos os arquivos foram extraidos para c:\scenario\SV000501,
exclua o SV000501.zip, de forma que vocé nado o selecione acidentalmente ao
importar seu sistema de arquivos.

Repita as etapas desta se¢do para os outros quatro arquivos .zip (SV000618.zip,
SV001585.zip, SV001586.zip e SV000514.zip.)

Criando os Projetos da Web

Nesta segdo, vocé criard projetos da Web para SV000514, SV000618, SV001585 e
5V001586. As etapas para criar cada projeto sdo descritas separadamente. Apesar
de parecerem repetitivas, lembre-se que existem algumas diferencas, pequenas
porém importantes, que devem ser observadas na criacdo dos quatro projetos
(relativas a quais arquivo EAR sdo associados a quais projetos).

Para criar os projetos da Web:

1.

Abra o IBM WebSphere Development Studio Client para iSeries no menu
Iniciar.

Em Development Studio Client, abra a perspectiva da Web com a barra de
menus, clicando em Window > Open Perspective > Other > Web e clique em
OK.

Clique em File > New > Dynamic Web Project.

a. No campo Project name, insira SV000514.

b. Marque a caixa de op¢des Configure advanced options e clique em Next.
c. Clique no botdao New ao lado do campo EAR project.
d

. No campo Project name, insira SVWholeSaleEAR e clique em Finish nas duas
caixas de didlogo.

Clique em File > New > Dynamic Web Project.

a. No campo Project name, insira SY001586 e clique em Next (A caixa de
opcdes Configure advanced options deve ser marcada automaticamente).

b. Verifique se SWholeSaleEAR esta selecionado no campo drop down EAR
project.

c. Clique em Finish.

Clique em File > New > Dynamic Web Project.

a. No campo Project name, insira SV000618 e clique em Next.
b. Clique no botdo New ao lado do campo EAR project.

c. No campo New project name, insira SVStoreEAR e clique em Finish nas
duas caixas de didlogo.

Clique em File > New > Dynamic Web Project.

a. No campo Project name, insira SV001585 e clique em Next.

b. Verifique se SVStoreEAR esta selecionado no campo drop down EAR project.
c. Clique em Finish.

Importando os Arquivos de Projeto da Web

Para importar os sistemas de arquivos para o espaco de trabalho, o procedimento a
seguir descreve como importar os arquivos em SV000514. O procedimento é igual
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para os outros trés sistemas de arquivos do projeto da Web: SV001586, SV001585 e
5V000618. A secdo que se segue a esta explica como criar e importar o projeto do
WebFacing.

Para importar arquivos:
1. Clique em Browse e navegue para
2. Clique com o botdo direito na pasta SV000514 e selecione Import.

3. A partir do assistente para Import, clique em File System e, em seguida,
clique em Next.

4. Procure o diretério no qual os arquivos do cendrio foram extraidos; por
padrdo, o diretério deve ser c:\wdsc\wdscsampl.

5. Clique em SV000514 e clique em OK.

6. Clique em Select All para assegurar que todos os componentes do sistema de
arquivos SV000501 sejam selecionados.

7. No campo Into Folder, insira SV000514, se ainda ndo estiver preenchido por
padrao.

8. Selecione a caixa de opgdes Overwrite existing resources without warning.

9. Clique em Finish e em Yes se receber algum didlogo perguntando sobre a
modificacdo da raiz de contexto.

10. Repita as etapas 2 a 9 para o SV001586, SV001585 e SV000618, certificando-se
de utilizar nomes de projetos diferentes conforme concluir as etapas.

Importando Arquivos de Projetos do WebFacing e Criando o
Projeto do WebFacing

O projeto SV000501 é diferente dos quatro projetos da Web que vocé acaba de criar,
pois SV000501 é um projeto WebFacing. Os projetos WebFacing sdo diferentes
porque incluem arquivos diferentes e tém uma estrutura exclusiva, especifica para
tratar arquivos DDS a partir do servidor iSeries.

Para importar os arquivos e criar um projeto WebFacing:

1. Se vocé ndo estiver na exibigdo Project Navigator, clique na guia Project
Navigator.

2. Dé um clique duplo dentro da exibicdo e selecione Import.
3. Ma janela Import, selecione WebFacing Projects e clique em Next.

4. Procure o diretério no qual os arquivos do cendrio foram extraidos; por padrao,
o diretdrio deve ser c:\wdsc\wdscsampl.

5. Selecione SV000501 e clique em OK. Clique em Next.

6. Na area de janela WebFacing projects found, selecione a caixa de opgoes
SV000501.

7. No campo Enterprise Application Project (EAR), digite SVStoreEAR.
8. Clique em Finish.
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Agora que todos os arquivos foram importados, o espago de trabalho deve ter esta
aparéncia:
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Ao ver erros ao lado de seus projetos importados, (indicados por marcas de x
vermelhas), clique com o botdo direito em cada projeto e selecione Rebuild
Project. Dependendo do que se encontra em seu espago de trabalho, esse
procedimento deve limpar a maioria dos erros, de forma que o aplicativo seja
executado adequadamente. Qualquer erro ainda observado pode estar ali porque
alguns codigos ndo foram completamente migrados para o release 5.1 do
Development Studio Client. Vocé pode dar continuidade aos exercicios deste
capitulo para se familiarizar com o produto, ou pode ir para o capitulo seguinte
para tentar construir os aplicativos a partir do rascunho.

Configuracéo do Servidor

Agora que vocé importou todos os arquivos de origem, € necessario configurar o
servidor do Ambiente de Teste do WebSphere para que ele reconheca os aplicativos
SVWholesaleEAR e SVStoreEAR.

Para configurar o servidor do Ambiente de Teste do WebSphere:

1. Va para a perspectiva Server. Na barra de menus do workbench, clique em
Window > Open Perspective > Other > Server e clique em OK.

2. Na visualizacdo Configuracdo do Servidor, clique com o botdo direito do mouse
em Servers e selecione New > Server and Server Configuration.

3. No campo Server name, insira Scenario server.
4. No campo Folder, insira Scenario folder.

5. Na caixa Server type, expanda o WebSphere version 5.0 e clique em Test
Environment, se ainda ndo estiver selecionado por padrao.

6. Clique em Finish e em Yes se receber alguma mensagem.
7. Para adicionar os arquivos EAR na configuragao do servidor:
a. Expanda Servers.
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b. Clique com o botdo direito do mouse em Scenario server e selecione Add >
SVWholeSaleEAR.

c. Expanda Servers.

d. Clique com o botdo direito do mouse em Scenario server novamente e
selecione Add and Remove Projects.

e. Selecione/clique no botdo Add All para mover SVStoreEAR e
SVWholeSaleEAR par o lado direito da janela.

f. Clique em Finish.

8. Na visualiza¢do de configuracdo do servidor, expanda Servidor do cendrio e,
em seguida, expanda SVStoreEAR e SVWholeSaleEAR para ver todos os
aplicativos relacionados:

Eﬂ SEwers

=] . SCENANID Server
- % SWSkoreEAR
@ SY000sO1
----- @ SYOOD618
g Swoo1585
= % SwrholeSaleEAR
----- @ SWOD1586
----- g SvoonS14
----- Eﬁ Urused Server Configurations

Para se certificar de que o servidor obteve os projetos:

1. Na exibigdo Servers, a direta da exibigdo Server Configuration, (clique na guia
Servers se ndo conseguir ver a exibigdo Servers), clique com o botdo direito do
mouse em Scenario server e selecione Publish. Uma caixa de didlogo
Publishing sera exibida, mostrando o andamento da publicacéo.

2. Clique em OK para publicar seus aplicativos no ambiente de testes do
WebSphere Application Server.

3. Apos a publicacdo, clique em OK na caixa de dialogo.

4. Na mesma visualizagao, clique com o botdo direito do mouse em Scenario
server novamente e clique em Start. A visualizacdo Console sera aberta,
mostrando as atividades do servidor. O servidor estara iniciado quando a
mensagem "Server servername open for e-business” aparecer na parte inferior da
visualizacdo. Role para baixo para ver todas as mensagens.

Configurando o Projeto WebFacing

Antes de executar o aplicativo ou de trabalhar com o médulo SV000501, é
necessario iniciar o servidor WebFacing para execugdo pelo aplicativo e configurar
o projeto para que ele utilize o servidor iSeries correto.

Para iniciar o servidor WebFacing;:
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1. Abra um emulador 5250 de tela verde e conecte-se com seu ID do usuério e
senha.

2. Na linha de comandos, insira strtcpsvr *webfacing.

3. Na parte inferior da tela, serd exibida a mensagem "WEBFACING server
starting”.

Agora é necessario alterar as propriedades do WebFacing, novamente no
workbench do Development Studio Client:

1. VA& para a perspectiva da Web (para alternar entre perspectivas, clique nos
icones em cluster no lado esquerdo da tela).

Clique na guia Project Navigator para ver as estruturas de projeto.
Expanda SV000501 e dé um clique duplo em Web Deployment Descriptor.
Clique na guia Parameters.

Clique em WFDefaultHost.

No campo Value, apague o valor existente e insira o nome do servidor iSeries.

N o gk wDd

Na barra de menus do workbench, clique no icone Salvar ou em File > Save
Web Deployment Descriptor. Se aparecer alguma mensagem, clique em OK.
Feche o arquivo.

Definindo Informacdes sobre o Servidor

Agora é necessario definir as informagdes sobre o servidor iSeries para os cinco
projetos, assegurando que estejam configurados para executar com o servidor
iSeries com seu ID do usuario e senha. Para definir informagdes sobre o servidor:

1. Certifique-se de que esta na perspectiva da Web.

2. Na visualizacdo do Project Navigator, clique com o botdo direito do mouse em
SV000501 e selecione Specify iSeries Web Tools Run-time Configuration.

3. No campo iSeries server name, exclua o valor existente e insira o nome do
servidor iSeries.

4. Exclua os outros valores existentes e insira o ID do usudrio e a senha.

o

Clique em Finish (e em Finish novamente, se necessario).

6. Repita as etapas de 2 a 5 para os outros quatro projetos: SV000514, SV000618,
SV001585 e SV001586.

Executando o Aplicativo no Workbench

Neste ponto, é possivel executar o aplicativo no Ambiente de Teste do WebSphere
no workbench. Depois de verificar se ele estd sendo executado corretamente, vocé
pode exportar o arquivo EAR para o servidor iSeries e implementa-lo no
WebSphere Application Server do iSeries.

Executando o Aplicativo como Cliente no Workbench

Como cliente, vocé comegaria na pagina da Web de compras da loja varejista,
consultaria os produtos e faria um pedido de uma determinada quantidade e
tamanho.

Nota: Podem ocorrer problemas se vocé tentar executar o aplicativo atrds de um
firewall, pois o arquivo web.xml procura o seguinte arquivo:

http:/ /java.sun.com/j2ee/dtds/web-app_2_2.dtd. Para resolver esse problema,
antes de executar o aplicativo, altere a instru¢do DOCTYPE em todos os arquivos
web.xml para:
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IDOCTYPE web-app PUBLIC "-//Sun Microsystems, Inc.//DTD Web Application 2.2//EN"
"x:/WDSC/eclipse/plugins/com.ibm.etools.j2ee/dtds/web-app_2_2.dtd"

em que x:/wdsc é o diretério no qual o produto foi instalado. Geralmente, os
arquivos web.xml podem ser localizados em Project name > Web Content >

WEB-INF. Depois de abrir o arquivo, clique na guia Source para editar o arquivo
diretamente.

Para executar o aplicativo como um cliente no Workbench:
1. Na perspectiva da Web, expanda SV001585 > Web Content.

2. Clique com o botdo direito do mouse em shop.html e selecione Run on Server.
Essa agao ativa o aplicativo no navegador o Ambiente de Trabalho.

3. Clique em Finish.
4. Entre no aplicativo, clicando na imagem das camisetas.

5. Tente inserir valores na pédgina seguinte, simulando que é um cliente fazendo o
pedido de um Pulover ou de uma Jaqueta, selecionando o tamanho e a
quantidade e adicionando itens na cesta de compras:
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A pégina que exibe o texto "your order has been processed” é a tltima da amostra.
Quando estiver satisfeito com a amostra, vocé podera fechar o navegador.

Executando o Aplicativo como Administrador no Workbench

Como administrador, vocé comegaria na pagina da Web de administragdo da loja
varejista e verificaria os pedidos e o inventdrio da loja. Para executar o aplicativo
como administrador no Workbench:

1. Na perspectiva da Web, expanda SV000618 > Web Content.

2. Clique com o botédo direito do mouse em index.html e selecione Run on
Server. Essa acdo ativa o aplicativo no navegador o Ambiente de Trabalho.

3. Clique no icone a esquerda de View store inventory para exibir a pagina a
seguir, como se vocé fosse um administrador decidindo o que comprar para a
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Tente clicar nos icones para exibir as paginas administrativas.

Implementando o Aplicativo de Cenarios no WebSphere Application

Server

Agora que vocé executou o aplicativo de cendrios do iSeries no ambiente de teste
do o Ambiente de Trabalho, poderd implementar o aplicativo no WebSphere
Application Server, como se estivesse executando o aplicativo real. Antes de
implementar o aplicativo, é necessario fazer alguns ajustes, como aplicar seguranca
na péagina do administrador e alterar o URL de um servi¢co da Web para que o
aplicativo indique o local correto, como explicado nas proximas segdes.

Nota: A implementagdo no WebSphere Application Server é opcional. Vocé pode
prosseguir com o proximo capitulo e concluir os médulos sem testar o
aplicativo no WebSphere Application Server.

Configurando o WebSphere Application Server

Anteriormente no capitulo, discutimos o [“Executando o Aplicativo no Workbench”]
Agora que vocé implementou os arquivos no servidor iSeries, podera
executar o aplicativo no iSeries utilizando o WebSphere Application Server.

Para implementar o aplicativo no WebSphere Application Server (opcional), é
necessario assegurar que:

* Vocé criou ou tem acesso a uma instancia do WebSphere Application Server
versdo 4.0, 5.0 ou WebSphere Application Server Express no servidor iSeries e

que a instancia esteja em execugdo (somente se desejar testar a implementacgao
no WebSphere Application Server).

* Vocé sabe os ntimeros de portas das instancias do HTTP e do WebSphere
Application Server no servidor iSeries.

* Vocé possui o0 WebSphere Administrative Console versao 4.0 ou 5.0 instalado na

estacdo de trabalho.
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Nota: Na versdo 5.0 do WAS, o console se baseia no navegador, portanto, ndo é
necessario ter um console na estacdo de trabalho. Consulte a documentagao

on-line para localizar informagdes adicionais sobre as diversas versdes do
WAS.

Seus aplicativos do iSeries ativados para Web utilizam WebSphere Application
Server para executar os servlets Java e as JSPs (JavaServer PagesTM) que fazem a
comunicacdo entre o navegador da Web do usudrio e os programas ou dados do
iSeries. Para servir paginas HTML e arquivos JSP do mesmo Sistema iSeries,
também é necessario ter um servidor HTTP nesse sistema. Recomenda-se a
utilizagdo do IBM HTTP Server powered by Apache. Vocé pode localizar a
documentacio sobre como utilizar esse servidor no: [[BM HTTP Server for iSeries|
Documentation Center, em|
http:/ /publib.boulder.ibm.com /pubs/html/iseries_http /v5r1/index.htm]

O WebSphere Application Server executa JavaServer pages, bean Java e servlets
Java gerados por diversos processos. Os recursos basicos da documentagdo do IBM
WebSphere Application Server para iSeries e do IBM WebSphere Administrative
Console para iSeries estdo disponiveis nos seguintes sites na Web:

+ [IBM WebSphere Application Server Versio 4.0 Advanced Edition for iSeries em|
http:/ /publib.boulder.ibm.com /was400/40/ AE /english /docs /|

* |IBM WebSphere Application Server Versao 4.0 Advanced Single Server Edition|
for iSeries em http://publib.boulder.ibm.com/was400/40/AEs/english/docs/

E altamente recomendado familiarizar-se com a documentagio do IBM WebSphere
Application Server, principalmente as se¢des sobre J2EE modules, Installing
WebSphere Application Server e Setting up multiple instances of the WebSphere
administrative server. No minimo, é necessério executar as etapas no link Installation.

Utilize o mapa do site para localizar informacdes sobre como instalar, configurar e
obter os PTFs necessarios para o WebSphere Administrative Console.

Aplicando Seguranca na Pagina do Administrador

Como a péagina do administrador, index.html, deve ser acessivel somente para
pessoas autorizadas, é necessdrio aplicar seguranca nela. Isto pode ser feito de
maneira programatica, na légica do aplicativo da web, ou utilizando o recurso de
seguranga do WebSphere. Neste cendrio, utilizamos a seguranca do WebSphere
para a pagina. Observe que utilizamos o WebSphere Application Server V4.0
Advanced Edition. Vocé localizard informacdes sobre o WebSphere Application
Server em seus sites na Web:

« |IBM WebSphere Application Server Versio 4.0 Advanced Edition for iSeries em|
http:/ /publib.boulder.ibm.com /was400/40/AE /english /docs /|

e [IBM WebSphere Application Server Versdo 4.0 Advanced Single Server Edition
for iSeries em http://publib.boulder.ibm.com/was400/40/AEs/english/docs/

e |Pagina dos RedBooks para WebSphere: Pesquise os RedBooks para WebSphere
Application Server Versao 5.0 e WebSphere Application Server Express Edition
Versdo 5.0 em http:/ /publib-

b.boulder.ibm.com /redbooks.nsf/portals/ Websphere|

Se estiver utilizando uma versao diferente do WebSphere Application Server,
consulte a documentagdo dessa versao a respeito de aplicacdo de seguranga nos
recursos da Web.
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A seguranga nos recursos da Web, como paginas e servlets, pode ser configurada
dentro do Development Studio Client ou na Ferramenta de Montagem do
Aplicativo. Neste cendrio, utilizamos o Development Studio Client.

Para revisar a configuracdo e as propriedades de seguranca deste aplicativo da
Web:

No Development Studio Client, va para a perspectiva da Web.
Na visualizagdo do Navegador, expanda SV000618 > Web Content > WEB-INF.
Dé um clique duplo em web.xml para abrir a visualizacdo web.xml.

Clique na guia Security.

o s w e

Para aplicar seguranca em index.html, na pagina de administracdo, uma
restricdo de seguranca também foi definida. Na parte superior da visualizagao,
clique em Security Constraints.

6. Clique na primeira instdncia de SecurityContraint na lista.
7. A direita, clique em AdminPage.

8. Clique em Edit para chamar a caixa de didlogo Web Resource Collections.
Observe que os métodos GET e POST para index.html estdo pré-selecionados.

9. Clique em OK.

Na secdo Security roles, observe a fun¢ao de seguranca definida, denominada
"Administrator”. Durante a implementacdo, as pessoas sdo atribuidas a essa
fungdo, obtendo acesso a pagina index.html. Na se¢do Authorized roles, observe
que demos a fun¢do Administrador acesso a esta restricdo de seguranca. Com esta
seguranga configurada, somente os usudrios designados com a funcéo
Administrador terdo acesso a pagina index.html, depois de terem fornecido as
credenciais corretas, como ID do usuédrio e senha. Quando houver seguranga
aplicada em um recurso, o WebSphere Application Server primeiro tenta autenticar
o usudrio. A autenticacdo é feita utilizando certificados ou solicitando ao usudrio
um ID do usudrio e senha. A solicitagdo pode ser feita com o didlogo basico de
autenticagdo ou com um formulario personalizado.

Neste cenario, desenvolvemos nossa prépria pagina de logon, denominada
login.jsp. Para configurar seu prompt de autenticacdo, selecione a guia Pages na
visualizagdo web.xml. Na secdo Login, observe que Form esta pré-selecionado
como método de Autenticagdo. Observe também que o nome da pagina Login é
login.jsp. A pagina Erro é exibida quando o logon nao é bem-sucedido. Nesse caso,
o aplicativo exibe novamente a pagina login.jsp.

Criando Arquivos EAR para Implementacao do iSeries
WebSphere Application Server

E necessdrio criar arquivos EAR para implementar seu aplicativo no iSeries
WebSphere Application Server. Um arquivo EAR é um arquivo JAR (Java Archive)
padrdo, com extensdo .ear. Esses arquivos podem conter varios projetos da Web e
podem ser utilizados para compactar e implementar aplicativos da Web no WAS
(WebSphere Administrative Server).

Para criar os arquivos EAR:
1. Va para a perspectiva da Web.

2. Na visualizacdo Navegador, clique com o botdo direito do mouse em
SVStoreEAR e selecione Export.

3. Na janela Export, clique em EAR file e em Next.
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5.
6.
7.

Em Where do you want to export the resources to?, clique em Browse e
navegue para um diretério no IFS (Integrated File System) do iSeries no qual
possa manter os arquivos EAR. (E necessério ter mapeado a unidade de rede
para um IFS do iSeries).

Insira SVRetailStorEAR.ear no campo File name e clique em Open.
Clique em Finish.
Repita as etapas 2 a 6 para o SVWholeSaleEAR.

Implementando os Arquivos EAR no iSeries WebSphere
Application Server

Agora que vocé criou os arquivos EAR, podera implementa-los no WebSphere
Application Server.

1.
2.

® N U AW

10.

11.
12.

13.
14.
15.

16.
17.
18.
19.
20.
21.

Abra o WebSphere Administrative Console.

Clique com o botdo direito do mouse em Enterprise Applications e selecione
Install Enterprise Application.

Selecione o botdo de opgdes Install Application (*ear).

Clique no botao Browse superior (o inferior ndo estard disponivel).
Navegue para o diretério IFS para o qual exportou os arquivos EAR.
Selecione SVRetailStorEAR.ear.

Insira "RETAILSTOR" no campo Application name.

Clique em Next e insira o ID do usudrio do servidor iSeries para a funcdo de
administrador.

Clique em Next vérias vezes, até chegar na pagina denominada Selecting
Virtual Hosts for Web Modules.

Nos trés médulos da Web, clique em Select Virtual Host e selecione o
servidor virtual de sua preferéncia na lista drop down. (Se ndo souber qual
selecionar, utilize default ou default_host).

Clique em Next.

Nos trés médulos da Web, clique em Select Server e selecione o servidor que
deseja utilizar. (Se ndo souber qual selecionar, utilize o Default Server).

Clique em Next.
Clique em Finish e em OK na caixa de dialogo.

Clique novamente com o botdo direito do mouse em Enterprise Applications
e selecione Install Enterprise Application.

Clique no botdo Browse inferior (o superior ndo estard disponivel).
Navegue para o diretdrio IFS no qual colocou os arquivos EAR.
Selecione SVWholesaleEAR.ear.

Insira "WHOLESALE" no campo Application name.

Clique em Next vérias vezes, até que Finish esteja ativo.

Clique em Finish e em OK na caixa de dialogo.

Nota: Pode demorar alguns minutos para que aparega uma mensagem de
confirmacao.

Executando o Aplicativo no WebSphere Application Server

Para assumir a fun¢do do cliente e executar o ponto de entrada da loja varejista,
insira o seguinte URL em um navegador da Web:

http://your iSeriesHostName:yourHTTPPortNumber/SV001585/shop.html

22 Aplicativo de Cenario da Loja de Varejo do iSeries



Para assumir a fun¢do do administrador e executar o ponto de entrada WholeSale,
insira o seguinte URL em um navegador da Web:

http://your iSeriesHostName:yourHTTPPortNumber/SVO00618/index.htm]

Se ndo souber o nimero da porta HTTP, pergunte ao administrador do WebSphere
Application Server.
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Capitulo 4. Modulo Passo a Passo 1: Criar um Servi¢go da
Web para Retornar Precos de Produtos (SV000514)

Introducéo

Neste médulo, vocé criard um servigo da web a partir de um programa RPG
existente no servidor iSeries para exibir precos de produtos para o inventario.
Primeiramente, crie um programa de servicos RPG com um procedimento que
possa recuperar o custo de um item do banco de dados do iSeries, fornecendo um
numero de item. Utilize o Assistente de Chamada do Programa das ferramentas de
desenvolvimento Java do iSeries para chamar o programa RPG e criar um bean de
servicos. Em seguida, utilize o assistente de Servigos da Web para criar um servigo
da Web e utilize a amostra gerada para verifica-lo.

Assistente de
“[— | chamada de ) Prog_rama de -
— | Programa servicos RPG
l Host iSeries
Bean de
servigos

= Assistente para
servigcos da Web

WSDL de servigos
da Web

Antes de Comecar

E possivel concluir os exercicios somente se os pré-requisitos a seguir forem
atendidos. Os pré-requisitos estdo descritos em mais detalhes em [Capitulo 3

[“Executando o Cendrio”, na pagina 9

¢ Vocé tem acesso TCP/IP a um servidor iSeries.

* Possuir os PTFs do servidor iSeries mais recentes aplicados. Consulte nossa
pagina de suporte para PTF e as informacdes do Service Pack:
|http: / /www.ibm.com /software /awdtools/wdt400/support/ |

¢ Vocé iniciou os servidores do iSeries com o comando STRTCPSVR *ALL

* Vocé iniciou o servidor WebFacing com o comando STRTCPSVR *WEBFACING
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* Vocé concluiu todas as tarefas do [Capitulo 3, “Executando o Cendrio”, na paginal
Ig, (exceto as tarefas opcionais do WebSphere Application Server, que nédo sédo
obrigatdrias para testar o aplicativo no o Ambiente de Trabalho).

Criando um Novo Projeto da Web

A primeira etapa na criagdo deste servigo da web é criar um novo projeto da Web
para conter as informagdes.

1. A partir do IDE do Ambiente de Trabalho, va para a perspectiva da Web ou
abra a perspectiva, clicando em Window > Open Perspective > Other > Web >
OK.

Clique em File > New > Dynamic Web project.

No campo Project name, insira Project514 .

Marque a caixa de opc¢des Configure advanced options e clique em Next.
Clique no botao New ao lado do campo EAR project.

ook~ wN

No campo Project name, insira Project514EAR e clique em Finish nas duas
caixas de didlogo.

Agora, vocé podera ver que os projetos Project514 e Project514EAR estao
adicionados no espago de trabalho na visualizag¢do Project Navigator.

Definindo as Informagdes do Servidor iSeries

Depois de criar o projeto da Web, é necessério definir qual servidor iSeries o
projeto utiliza para obter informacdes.

1. Clique com o botdo direito do mouse no projeto Project514 e selecione Specify
iSeries Web Tools Run-time configuration.

2. Insira o nome do servidor iSeries no qual a biblioteca WHOLESALE restaurada
reside, por exemplo, PROD400.

3. Insira o ID do usudrio e a senha deste servidor iSeries.
4. Digite Wholesale no campo Library e clique em Add.
5. Clique em Finish.

Criando o Programa de Servigcos RPG

Vocé deseja que o aplicativo recupere o preco de um item, fornecendo o niimero
do item. Isto é tratado por um programa de servicos do RPG que contém um
procedimento denominado QryProdCost. A biblioteca WHOLESALE contém um
programa de servigos do RPG denominado CWWSSRV. Esse programa contém um
procedimento QryProdCost que pode considerar os niimeros de itens como
entrada, abrir o arquivo de Inventario dentro da biblioteca WHOLESALE,
recuperar o preco do banco de dados de inventario e retornar esse preco. Para
ajudar essa tarefa, a interface tem dois parametros, um para o nimero do item e
outro para o preco. Se o niimero ou o prego do item ndo for localizado, o
programa RPG retornard uma mensagem para a interface.

Para criar este servico da Web, primeiro crie um bean Java com o assistente de
Chamada do Programa, para chamar o procedimento RPG QryProdCost. Em
seguida, utilize os servicos da Web para ativar o procedimento RPG como servigo
da Web, por meio do bean Java.

Para criar o bean Java:
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Criando

Na perspectiva da web, clique com o botdo direito do mouse em Project514 e
selecione New > Other.

Selecione iSeries > Java a partir do painel esquerdo da janela e, em seguida,
selecione Program Call Bean no painel direito.

Clique em Next para chamar o assistente de Chamada de Programa.
No campo Java bean name, debaixo do titulo Add Program, insira Inventory.

No campo Program object, insira CWWSSRV, o nome do programa de servigos
RPG.

No campo Library, insira WHOLESALE.

Na lista drop down Program type, selecione *SRVPGM.
No campo Entry point, insira QryProdCost.

Clique em OK para adicionar a definicdo do programa.

os Parametros e Gerando o Bean Java

Agora que o programa foi especificado, vocé pode adicionar parametros. O
programa RPG CWWSSRV contém estes dois pardmetros:

* Pardmetro Numero do item - O programa utiliza esse niimero para localizar o

item no banco de dados.

e Parametro Custo do item - O programa utiliza esse ntimero para localizar o

custo do item no banco de dados.

Para adicionar o pardmetro Custo do item:

1.

© No gk~ wdN

No painel da esquerda do assistente de Chamada de Programa, clique na
definicdo de chamada de programa Inventory para selecioné-la. Essa agdo
ocupa novamente os campos no lado direito da pagina.

Clique em Add Parameter.

No campo Parameter name, insira itemno.

Na lista drop down Data type, selecione packed decimal.
No campo Length, insira 5.

No campo Precision, insira 0.

Na lista drop down Usage, selecione input.

Clique em OK para adicionar esse pardmetro. No painel esquerdo, observe que
itemno aparece abaixo de Inventory. Agora vocé estd pronto para adicionar o
segundo parametro.

Para inserir o parametro Custo do item:

1.

© No ok wDdN

No painel da esquerda do assistente de Chamada de Programa, clique
novamente na definicdo de chamada de programa Inventory para selecioné-la.
Essa acdo ocupa novamente os campos no lado direito da pagina.

Clique em Add Parameter.

No campo Parameter name, insira cost.

Na lista drop down Data type, selecione packed decimal.
No campo Length, insira 7.

No campo Precision, insira 2.

Na lista drop down Usage, selecione output.

Clique em OK para adicionar esse paradmetro. No painel esquerdo, observe que
cost aparece abaixo de Inventory. Neste ponto, o assistente terd esta aparéncia.
Observe que o icone a esquerda do pardmetro mostra se ele é do tipo entrada e
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Para definir o nome do pacote para esses pardmetros, no assistente de Chamada de

Programa:

1. Clique em Next.

2. No campo Package, insira scenario como nome do pacote. Deixe os padrdes
nos outros campos.

3. Limpe a caixa de entrada Java Application.

Nota: Revise a lista de arquivos em "These files will be generated by the
wizard” e observe que o nome do bean Java gerado sera
InventoryServices.java.

4. Clique em Finish para gerar os arquivos.

Criando um Servi¢co da Web a partir do Bean Java

Depois de criar o bean Java que chama o programa RPG, a préxima etapa é
converter o bean em servico da Web para que outros programas possam acessar o
mesmo programa RPG pela Internet.

Ao criar o servico da Web, um assistente de Servicos da Web gera os arquivo
WSDL que sdo distribuidos aos usudrios que precisam utilizar o Servigo da Web.

Para criar o servigo:

1. Na visualizacdo do Navegador da perspectiva da Web, expanda Project514 >
Java Source > scenario.

2. Clique com o botdo direito do mouse em InventoryServices.java e selecione

New > Other.

3. Na janela New, clique em Web Services, em Web Service no lado direito da

janela e em Next.

4. Selecione as caixas de opcdes Generate a proxy e Test the generated proxy.
5. Clique em Next trés vezes e observe a geracdo dos arquivos necessarios. Ao

surgir a janela Web Service Java Bean Identity, clique em Finish. Pode ser
necessario clicar em Finish uma segunda vez se for observado algum erro. Se
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vocé nao conseguir concluir o assistente, apenas clique em Cancel e a maioria
dos arquivos necessarios sera criada de qualquer forma.

Testando a Amostra

Quando vocé criou o servico da Web, uma das instrugdes foi solicitar a geragdo de
uma amostra. Como essa opcdo foi selecionada, o assistente Servigos da Web criou
um novo projeto com as paginas de teste, que pode ser utilizado para testar o

servico da Web. Na visualizacdo Navigator, observe que o nome desse novo

projeto é Project514Client. Observe também que a ferramenta abriu

automaticamente TestClient.jsp, no lado direito do workbench. Esse arquivo esta
localizado em Project514Client > Web Content > sample > InventoryServices.

Para testar a amostra:

1.

Na pagina carregada, role para baixo a area de janela de métodos até o fim.
Clique no método Inventory (java.math.BigDecimal).

No campo itemno, insira 4 e clique em Invoke.

Verifique se a saida retornada é:

result:
cost: 12.99
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Quando o resultado for confirmado, vocé tera concluido o médulo. Vocé criou o
servico da Web que retorna pregos de produtos na interface do aplicativo.
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Capitulo 5. Modulo Passo a Passo 2: Criar uma Interface para
Visualizar Inventario e Itens de Pedidos (SV000501)

Introducéo

Neste médulo, vocé criard uma interface que exibe as opg¢des de operacdao de um
administrador, utilizando WebFacing Tool da IBM. Apés um login com éxito no
servidor iSeries, a interface exibe o inventério disponivel e vocé poderd verificar
pedidos existentes. Como administrador, vocé poderd comprar mercadorias do
fornecedor atacadista.

Login
Servidor bem-sucedido

l Exibir pedidos do cliente
= Administration
‘:” page Order # Date Quantity = Item Size
View orders WebFacing —». 74635 | 01/02/02 35 12345 S
View inventory: Tool

Purchase from supplier

Close Exibir inventario

WebFacing—»| L q Price: Price:

Tool ltem #  Description = Quantity iy sell

Assistente de
Chamada de Programa 12346  Jacket 100 75.99 85.99
12347 | Hat 56 6.99 8.99
= Next page 12345 | T-shirt 100 3599 | 39.99
- (project SV001586)

Neste projeto, vocé trabalha com dois programas e dois arquivos de exibi¢do
restaurados para o servidor iSeries. Os nomes dos programas sdo ViewInventory e
ViewOrder. Eles utilizam os seguintes arquivos de exibigdo: ORDERDSP e QUERY.
Esses dois arquivos contém definicdes da Web personalizadas para os arquivos JSP
gerados pelo WebFacing Tool e sdo utilizados para imagens e hyperlinks. A
defini¢do da Web da imagem permite utilizar o conteido de um campo para gerar
o nome do arquivo de imagem e exibi-la no arquivo JSP. A defini¢do da Web do
hyperlink permite chamar outro aplicativo da Web quando vocé clica na imagem
no arquivo JSP. E possivel utilizar o CODE Editor ou o CODE Designer para
verificar o cédigo fonte do arquivo de exibigdo, para determinar como especificar
as defini¢des da Web.

Antes de Comecar

E possivel concluir os exercicios somente se os pré-requisitos a seguir forem
atendidos. Os pré-requisitos estdo descritos em mais detalhes em [Capitulo 3

“Executando o Cendrio”, na pagina 9

e Vocé tem acesso TCP/IP a um servidor iSeries.
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* Vocé iniciou os servidores do iSeries com o comando STRTCPSVR *ALL
* Vocé iniciou o servidor WebFacing com o comando STRTCPSVR *WEBFACING

¢ Vocé concluiu todas as tarefas do [Capitulo 3, “Executando o Cendrio”, na pagina
E (exceto as tarefas opcionais do WebSphere Application Server, que nédo sdo
obrigatérias para testar o aplicativo no o Ambiente de Trabalho).

Criando um Projeto WebFacing

A primeira coisa a ser feita é criar um projeto WebFacing e especificar os comandos
CL relevantes. Para criar o projeto WebFacing:

1. No o Ambiente de Trabalho, alterne para a perspectiva WebFacing, clicando
em um dos icones de perspectiva no lado esquerdo do espaco de trabalho ou
clicando em Window > Open Perspective > Other > WebFacing e em OK.

2. Crie um novo projeto WebFacing, clicando em File > New > Project
WebFacing.

3. Dé ao projeto o nome Project501.

4. Clique no botdo de opgdes Existing ao lado de Enterprise Application
Project.

5. Insira SVStoreEAR no valor do campo Existing project name; ndo se o valor
fizer distin¢do entre maitsculas e mintsculas. Clique em Next.

6. Na lista drop down J2EE level, selecione 1.3. Clique em Next.

7. No campo Connection, o nome de seu servidor iSeries deve ser preenchido
automaticamente. Caso contrério, clique em New e insira o nome do servidor
iSeries no dialogo e clique em Finish.

8. Clique em Refresh DDS list e insira a senha e o ID do usudrio no didlogo
popup, para atualizar a lista.

9. Na lista de bibliotecas gerada, expanda RETAILSTOR.

10. Clique em QDDSSRC e, em seguida, na seta para a direita (>>), a fim de
mover 0s arquivos.

11. Clique em Next duas vezes, até chegar a pagina Specify CL commands.
Agora é necessario adicionar um comando e um rétulo de comando para o
administrador:

12. No campo CL command, insira call viewinvent.

13. No campo Command label, exclua os valores existentes e insira View
inventory.

14. Selecione o botdao de opcdes Sign on with specified values.

15. Clique em Add e observe a adigdo na lista, na parte inferior da janela.
Agora é necessario adicionar um segundo comando e um rétulo de comando para
o cliente:

16. No campo CL command, exclua o valor existente e insira call vieworder.
17. No campo Command label, exclua os valores existentes e insira View orders.
18. Selecione o botdao de opc¢des Prompt for signon.

19. Clique em Add e observe a adicdo na lista, na parte inferior da janela. Clique
em Next.

20. Na janela Choose a Web style, role pelos estilos para ver o que esta
disponivel. Como precisamos recuperar informacdes deste estilo depois,
selecione avenue para este médulo. Clique em Next.

21. Verifique se a caixa de opgoes No. I only want to create the project now esta
selecionada e clique em Finish.
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22. Se aparecer uma mensagem Reparar configuracdo do servidor, clique em OK.
Essa mensagem é apenas para confirmar se vocé deseja que o projeto seja
adicionado no arquivo SVStoreEAR.

Como vocé esta construindo o Project501 como espelho do projeto SV000501
completo, agora é necessario copiar alguns dos arquivos de imagem do SV000501
para o Project501, para que o Project501 seja exibido corretamente (Se desejar, vocé
pode adicionar suas préprias imagens na interface). Para copiar as imagens:

1. VA& para a perspectiva da Web.
2. Na visualizagdo do Navegador, expanda SV000501 > Web Content > images.

3. (Opcional) Expanda generated para anotar todas as imagens que estdo sendo
importadas para o projeto.

Clique com o botdo direito do mouse em generated e selecione Copy.

Expanda Project501 > Web Content.

Clique com o botao direito do mouse na pasta images e selecione Paste no
menu pop-up.

4
5. Role para cima na visualizagdo Navegador, até ver Project501 novamente.
6
7

8. Agora, a pasta generated existe para o Project501. Expanda generated para
anotar as imagens adicionadas.

Convertendo a Origem DDS

Agora que vocé criou o projeto, poderd converter os arquivos de exibi¢do DDS em
arquivos JSP para a pagina da Web. Quando vocé converte os arquivos de exibigdo
DDS, a WebFacing Tool gera JSPs e arquivos XML que substituem o cédigo DDS e
tornam possivel o acesso a Web. Os arquivos gerados contém os dados do formato
de registro ou controlam sua aparéncia, exibi¢do da versdo da Web da tela, prompt
de dados e tratamento de erros de entrada. O assistente também gera uma home
page do aplicativo para ativar a versao do programa ativada para a Web.

No entanto, primeiro é necessario alterar a origem para fazer referéncia ao servidor
iSeries correto. Mais especificamente, é necessério fazer uma modificagio em um
dos arquivos DDS de exibigao, para que o link do aplicativo funcione. E necessario
alterar o nome padrdo, SV000501, para o nome do projeto, Project501:

1. Volte para a perspectiva WebFacing e alterne para a visualizacdo WebFacing
Projects se esta ainda ndo estiver aberta por padrao.

2. Expanda Project501 > DDS.

3. Dé um clique duplo na segunda entrada,
<servidor_iSeries>RETAILSTOR/QDDSSRC(QUERY)

4. Role para baixo até aproximadamente a linha 16, na qual podera ver a linha:
Ax%%WB 12 FLD 1 next ('/SV000501/DetailPage.do?PRODNO=&{PRODNO}")

5. Exclua SV000501 e insira Project501.

6. Salve e feche o arquivo.

Nota: Se em algum ponto vocé desejar executar o projeto SV000501 novamente,
deverd retornar o valor Project501 para SV000501, ja que esse arquivo existe
no servidor iSeries e é acessado pelos dois projetos.

Para converter a origem DDS:

1. Na perspectiva WebFacing, clique na guia WebFacing Projects para alternar
para a visualizagdo WebFacing Projects se esta ja ndo estiver aberta por padrao.

2. Expanda Project501 > DDS.
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3. Selecione iSeriesserver > RETAILSTOR/QDDSSRC(ORDERDSP) e iSeriesserver
> RETAILSTOR/QDDSSRC(QUERY), clicando no primeiro e mantendo a tecla
Shift pressionada enquanto clica no segundo.

4. Clique com o botao direito e selecione Convert para iniciar a conversao. Pode
ser necessario inserir o ID do usudrio e a senha, se em algum ponto vocé for
desconectado do servidor iSeries.

Configurando Suporte a UTF-8 no Ambiente de Trabalho —
Somente para Usuarios do WAS Verséo 4.0

Os aplicativos WebFacing Tool da IBM oferecem suporte a exibi¢do de varios
idiomas em uma tela. Como os idiomas utilizam conjuntos de caracteres diferentes,
os fluxos de dados entre o navegador e o WebSphere Application Server tém
codificacdo UTF-8. Para que WebFacing Tool da IBM funcione corretamente, é
necessdrio configurar o suporte a UTF-8 no arquivo de propriedades do aplicativo
no o Ambiente de Trabalho.

Nota: Esta secdo é véalida somente para usudrios do WAS 4.0. O WAS versao 5.0
executa esta tarefa automaticamente.

Para configurar suporte a UTF-8:

1. V& para a perspectiva da Web (para alternar entre perspectivas, clique nos
icones em cluster no lado esquerdo da tela).

Clique na guia Project Navigator para ver as estruturas de projeto.
Expanda Project501 e dé um clique duplo em Web Deployment Descriptor.
Clique na guia Environment.

Clique no botdo Add.

No o bk owobd

V4 para a perspectiva Servidor, clicando em seu icone na barra de tarefas
superior esquerda, ou clique em Perspective > Open > Other > Server na
barra de menus e em OK.

8. Na visualizacdo Navegador, expanda a pasta Servers.
9. Dé um clique duplo em defaultInstance.wsi para abri-lo no editor padrao.
10. Clique na guia Environment e no botao Add.

11. Sera exibido um valor editavel, "(New Variable)”. Exclua essa cadeia padrdo e
insira: client.encoding.override.

12. No campo Value, insira UTF-8.
13. Clique no icone Salvar ou em File > Save Web Deployment Descriptor.

Configurando Suporte a UTF-8 para o WebSphere Application
Server

(Opcional) Para implementar o aplicativo iSeries no WebSphere Application Server,
também € necessario configurar suporte a UTF-8 no WebSphere Application Server
e no o Ambiente de Trabalho.

Para Configurar Suporte a UTF-8 no WebSphere Application
Server 4.0 Advanced Edition

1. Inicie o WebSphere Administrative Console.
2. Expanda o icone Nodes e Node name > Application servers > Default server.

3. Selecione a guia JVM Settings e clique no botdo Advanced JVM settings para
abrir o didlogo Advanced JVM settings.
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4. No campo Command line arguments, insira:
-Dclient.encoding.override=UTF-8
5. Clique em OK e em Apply na guia JVM settings.

6. Para que esta alteragao seja efetivada nos aplicativos WebSphere, pare o
servidor padrdo e, em seguida, inicie-o novamente. Para parar o servidor,
clique com o botado direito do mouse em Default server e selecione Stop. Ao
concluir esse processo, clique com o botado direito do mouse em Default server
e selecione Start.

Para Configurar Suporte a UTF-8 no WebSphere Application
Server 4.0 Advanced Single Server Edition

1. Inicie o WebSphere Administrative Console.

2. No Console Administrativo com base no navegador, expanda o icone Nodes e
Node name > Application servers > Default server > Process definition >
JVM settings.

3. Role até a secdo Defini¢des Avangadas da pagina Defini¢cdes de JVM e clique no
link Propriedades do sistema. A paginas de Propriedades do Sistema ¢é exibida.

Clique em New para adicionar uma nova Propriedade do Sistema.
No campo Name, insira client.encoding.override.
No campo Value, insira UTF-8.

N o gk

Clique em OK. Se for exibida uma mensagem Configuration needs to be saved
com um link na parte superior da pagina JVM settings, clique no link para ir
para a pagina Save configuration. Selecione Save e clique em OK.

8. Para que esta alteragdo seja efetivada nos aplicativos do WebSphere, pare o
servidor de aplicativos e, em seguida, inicie-o novamente. O método para parar
e iniciar o servidor de aplicativos pode variar, dependendo da plataforma na
qual o WebSphere Application Server foi instalado. Consulte a documentacao
do WebSphere Application Server para sua plataforma para obter informacoes
sobre como parar e iniciar o servidor de aplicativos.

Criando uma Pagina de Estilo

Para integrar paginas adicionais com uma CSS (Cascading Style Sheet), é
necessario personalizar o estilo do projeto WebFacing ou a CSS, para que fiquem
parecidos. Depois de personalizar a pagina de estilo, vocé podera utilizar o
assistente de Interagdo com a Web para criar uma pagina da Web detalhada,
utilizando a pagina de estilo, para exibir informacées sobre itens da loja, como
preco e cor. Neste médulo, vocé vai incorporar a pagina de estilo
DetailPageResults.jsp do projeto SV000501. Para referéncia futura, vocé pode
personalizar manualmente o arquivo CSS (descrito na préxima segao).

(Opcional) Personalizando Manualmente uma Pagina de Estilo
em Cascata

Conforme mencionado anteriormente, em vez de incorporar a pagina de estilo
DetailPageResults.jsp do projeto SV000501 para o Project501, vocé pode
personalizar suas proprias paginas de estilo:

1. Alterne para a visualizagdo do Project Navigator e expanda Project501 > Web
Content > styles > apparea.

2. Dé um clique duplo em apparea.css para abrir o arquivo no Designer CSS. Essa
pagina de estilo controla a aparéncia da area do aplicativo.

3. Modifique e salve o arquivo.
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4. De volta na visualizagdo do Project Navigator, navegue para Project501 > Web
Content > styles > chrome.

5. Dé um clique duplo em avenue.css para abrir o arquivo no Designer CSS. Essa
pagina de estilo controla a aparéncia da pagina inteira.

6. Modifique e salve o arquivo.

Estendendo e Aprimorando seu Projeto WebFacing com uma Interacao
da Web

Nesta se¢do, vocé vai aperfeigcoar o projeto WebFacing. Quando a lista de itens for
exibida, vocé tem que clicar em uma imagem de item para ver detalhes sobre esse
item. Para isto, utilize o assistente de Interacdo com a Web para chamar um
programa RPG para recuperar os detalhes do item e exibi-los em outra pagina da
Web. Vocé executara as seguintes etapas:

 definir as informacdes do servidor

* copiar a pagina de estilo correta

e criar a interagdo

¢ adicionar programas e parametros na interagdo
* alterar o uso dos parametros

Primeiro, é necessario definir as informagdes sobre o servidor:
1. Va para a perspectiva da Web.

2. Na visualizacao Navigator, clique com o botédo direito do mouse em Project501
e selecione Specify iSeries Web Tools run-time configuration.

3. Insira o nome do servidor iSeries, o ID do usudrio e a senha.
4. Digite Retailstor no campo Library e clique em Add.
5. Clique em Finish. Clique em Finish novamente, se necessario.

Antes de criar a Interacdo com a Web, é necessario copiar os estilos e paginas de
estilo corretos, para que o Project501 exiba o formato de arquivo JSP correto (se
vocé tiver concluido o exercicio|’(Opcional) Personalizando Manualmente umal
[Pagina de Estilo em Cascata” na pagina 35, ndo serd necessario executar esta
tarefa). Primeiro, copie a pasta de estilos e, em seguida, copie o
DetailPageResults.jsp:

1. Na visualizagdo do Navegador, expanda SV000501 > Web Content.

2. Clique com o botdo direito do mouse em Styles e selecione Copy.
3. Role para cima na visualizagdo Navegador, até ver Project501 novamente.
4

Expanda o projeto, clique com o botao direito do mouse em Web Content e
selecione Paste no menu pop-up. Clique em Yes para sobrescrever os estilos
existentes.

Role para baixo, até SV000501 > Web Content.

6. Clique com o botdo direito do mouse em DetailPageResults.jsp e selecione
Paste.

o

7. Role para cima, até ver Project501 novamente.

8. Expanda o projeto, clique com o botdo direito do mouse em Web Content e
selecione Paste no menu pop-up.

Observe os novos elementos adicionados abaixo da pasta Contetido da Web do
Project501.

Agora, vocé podera criar a Interagdo com a Web:
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7.

Agora, vocé poderd adicionar programas e parametros na interagdo. E necessario

Clique em File > New > Other

No didlogo New, clique em Web no lado esquerdo e em Web Interaction no
lado direito. Clique em Next.

No campo Web Interaction name, insira DetailPage e clique em Next.
Selecione o botao de opgdes Generate Input JSP.

Selecione o botdo de opg¢des Use output pages (se ainda ndo estiver
selecionado) e clique em Add.

No didlogo Output JSP, expanda Web Content, selecione
DetailPageResults.jsp, a pagina de saida pré-formatada e clique em OK.

Clique em Next.

adicionar 11 pardmetros no mesmo programa. Em vez de adicionar cada pardmetro

com seus valores individuais manualmente, adicione-os de uma forma um pouco

mais rdpida:

Observe que DetailPage foi adicionado no lado esquerdo do assistente, abaixo de

P wbd PR

5.

Selecione Use an iSeries ILE program, se ainda ndo estiver selecionado.
Clique em Add Program.

No campo Program alias, insira DetailPage.

No campo Program object, clique em Browse.

a. Expanda iSeriesserver > *LIBL > RETAILSTOR.

b. Clique em DETAILPAGE.*pgm.rpgle (o primeiro arquivo abaixo de
RETAILSTOR) e clique em OK.

De volta para o assistente de Interacdo com a Web, clique em OK (no canto

inferior direito).

Defini¢des de chamada do programa.
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Na segdo Defini¢gdes de chamada do programa no painel esquerdo do
assistente, clique em DetailPage para selecionar essa opgao.

Clique em Add Parameter.

Ao lado de Specify database reference field, na parte inferior do assistente,
clique em Specify.

Expanda iSeriesserver > *LIBL > RETAILSTOR > INVENTORY.*file.pf-dta >
INVFORMAT para exibir uma lista de 13 parametros. E necessério adicionar
os 11 parametros a seguir, clicando uma vez em cada um deles e em Add, ou
mantendo a tecla CTRL pressionada enquanto clica em cada um deles e
clicando em Add: PRODNO, PRODNAME, COLOR, RPRICE, IMAGE, STYLE,
SQTY, MQTY, LQTY, XLQTY, XXLQTY. Basicamente, vocé selecionara todos os
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campos, exceto PPRICE e QTY.
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10. Clique em Close.

Agora, é necessario alterar o uso de 10 dos 11 pardmetros para "output” (todos os

parametros, exceto PRODNO).

1. Ainda no assistente de Interacdo com a Web, clique em PRODNAME para

selecionar essa opgao.

2. Na caixa de combinagdo Usage, troque o valor selecionado para output e clique
em OK. Repita essa etapa (com a etapa anterior) para todos os parametros,
exceto o primeiro (PRODNO). Quando tiver ajustado todos os parametros, o
espaco de trabalho terd a seguinte aparéncia. Observe que o icone a esquerda
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do parametro mostra se ele é do tipo entrada, entrada e saida ou saida.

‘Web Interaction

Specify the Input and Outpuk Parameters for your iSeries Host Program
Usz this page bo define the input and output parameters For vour 13enies hosk progr am,

(% Use aniSeties ILE program " Use & Java bean € N prograrn call
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g8 3 PRCOMAME W

@ COLOR Parameter name: 0
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- IMAGE StruckLre mame: v I

g STYLE
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= Back I sk = | Einizh |

Cancel

3. Clique em Next para consultar a visualiza¢gdo Input Form.
4. Clique em Finish para criar a Interacdo com a Web.

5. Selecione Yes to all ou OK e Finish novamente, se for exibida alguma
mensagem.

Vincular o Projeto a uma Interagdo com a Web

Agora que vocé criou um arquivo JSP de Interacdo com a Web que utiliza

parametros de entrada e saida, deverd personalizar esse arquivo JSP para que ele
também funcione com o componente WebFacing. E necessério inserir o c6digo para
criar um link a partir do aplicativo WebFacing para chamar esta Interacdo com a
Web. Para isto, adicione uma fungdo JavaScript no arquivo webface.js, para que
possa chamar o servlet DetailPageServlet com o pardmetro PRODNO em uma

nova janela.

Para criar o link:

1. Na visualizagdo do Navegador, expanda Project501 > Web Content >
ClientScript.

2. Dé um clique duplo em webface.js para abri-lo em um editor.

3. Role para a parte inferior do arquivo e insira as seguintes linhas:

var mywindow
function next(app)

{
mywindow = window.open(app,"Details","RESIZABLE=YES,

HEIGHT=700, WIDTH=800");
}

4. Clique no icone Salvar ou em File > Save webface.js.
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Para criar um aplicativo semelhante ao SV000501 no futuro, também sera
necessario alterar uma definicdo da Web na origem DDS para ativar a imagem que
foi adicionada e ativar também o link para fechar a janela na funcédo JavaScript.

O cédigo RPG incluido neste aplicativo € alterado para mostrar a alteragdo, no
entanto, serd necessario fazer a alteracdo manualmente nas préximas aplicacdes.
Além disso, depois de alterar as defini¢des da Web, sera necessédrio converter a
origem DDS.

Vocé pode verificar o cddigo para duplicar o resultado.

Para visualizar a origem DDS:
1. Abra a perspectiva WebFacing.
2. Na visualizacdo de projetos WebFacing, expanda Project501 > DDS.

3. Clique com o botdo direito do mouse em <servidor_iSeries >
RETAILSTOR/QDDSSRC(QUERY) e selecione Open With > CODE
Designer.

Depois de abrir o CODE Designer, expanda SCREEN1 > ITEMSUB.
Clique em IMAGESRC para selecionar essa opgao.

Clique na guia Source.

N o o s

Clique na guia Web Settings, na parte inferior direita da janela.

Nota: Verifique as propriedades da Definicdo da Web, como a largura em
pixels e o nome do arquivo. Futuramente, serd necessario fazer as
mesmas alteragdes na origem DDS e reconverté-la.

8. Observe as seguintes linhas na origem:

A PRODNO R 056

A PRODNAME R 0 5 16

A IMAGESRC ~ 19A 0 5 33

A+%%WB 13 FLD 100|100|&{IMAGESRC}

Ax%%WB 12 FLD 1 javascript:next
('/Project501/DetailPageServ1et?PRODNO=&{PRODNO} ")

Observe principalmente que Project501 € especificado na tltima linha.
Conforme mencionado anteriormente, para executar o aplicativo SV000501
novamente, é necessario retornar o valor de Project501 para SV000501.

9. Salve o arquivo, clicando no icone Salvar ou em File > Save na barra de
menus.

10. Feche o arquivo e o CODE Designer.

Para obter informagdes adicionais sobre como trabalhar com a Origem DDS, va
para a perspectiva de ajuda do o Ambiente de Trabalho e consulte a documentagéo
da IBM WebFacing Tool.

Publicando os Arquivos e Iniciando Novamente o Servidor

Nesta segdo, vocé publicarad seus arquivos e iniciara novamente, para que o
aplicativo Project501 possa receber todas as alteragdes.

No entanto, antes de iniciar novamente o servidor, é necessario verificar se o
Project501.war foi adicionado no arquivo SVStoreEAR.

Para verificar a configuragao:
1. Na visualizagdo do Navegador, expanda a Scenario folder.
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2. Dé um clique duplo em Scenario server.wsi.

Podera ser exibido um didlogo perguntando se vocé deseja que o editor corrija as
entradas do projeto automaticamente. Clique em Yes. Se ndo aparecer um dialogo,
ndo serd necessario executar nenhuma agdo. De qualquer forma, o arquivo serd
modificado automaticamente quando for aberto.

3. Salve e feche o arquivo.

Para iniciar novamente o servidor:
1. Alterne para a perspectiva Servidor.

2. Na visualizacdo Configuragdo do Servidor, no canto inferior esquerdo, expanda
Servers e dé um clique duplo em Scenario server.

3. Clique na guia Servers no canto inferior direito da tela para ver o status do
servidor na visualizagdo Servidores.

4. Clique com o botao direito do mouse em Scenario server e selecione Publish.
Clique em OK quando a publicagdo for concluida.

5. Clique com o botdo direito do mouse no servidor na visualizacdo Servidores e
selecione Start ou Restart (o que estiver ativado). Se aparecer algum aviso a
respeito de arquivos nao salvos, cancele o dialogo, salve os arquivos abertos e
continue.

6. Verifique as informagdes de log do Console (aberto automaticamente). Vocé
saberd que o servidor foi iniciado quando for exibida a seguinte linha na parte
inferior do log: Servidor server_name aberto para e-business.

Testando a Interface

Vocé concluiu as etapas necessarias para criar uma interface de visualizacdo de
pedidos e de inventdrio. Para testar a interface:

1. Va para a perspectiva da Web.
2. Expanda Project501 > Web Content.

3. Clique com o botdo direito do mouse em index.html e selecione Run on
Server.

4. Um dialogo Server Selection sera aberto. Verifique se Scenario server esta
selecionado por padrao e clique em Finish.

5. Clique em View orders — Launch in main browser window para chamar o
aplicativo administrador. Depois de efetuar login com seu ID do usuério e
senha do iSeries (para o servidor iSeries utilizado no desenvolvimento deste
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projeto), vocé sera direcionado para a seguinte pagina:
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Tente inserir um X ao lado de um dos niimeros de produto para ver detalhes
sobre ele.

6. Clique na seta para trds para obter a pagina index.html e clique na janela View
inventory — Launch in main browser para chamar o aplicativo cliente. Vocé
serd direcionado para a seguinte pagina (depois de efetuar logon no servidor
iSeries com seu ID do usuério e senha):

b Server - WebSphere Development Studio Client Advanced Edition for iSeries i 5 =
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Tente clicar em uma imagem para exibir detalhes sobre um item especifico.

Vocé concluiu 0 médulo! Vocé criou uma interface com o usudrio para visualizar o
inventdrio e itens do pedido.
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Capitulo 6. Modulo Avancado 1: Criar HTML, Servlets e
Arquivos JSP que Fazem Pedidos do Cliente em um Servidor
ISeries (SV001585)

Introducao

Este projeto é destinado a usuarios com bons conhecimentos em programacéo Java
e algum conhecimento de gerenciamento de dados do iSeries e RPG. O projeto
mostra como trabalhar com as classes de acesso a dados do IBM Toolbox para
iSeries, o bean RecordlOManager e o bean de Chamada de programa para criar
codigo HTML, servlets e JSPs que fazem pedidos do cliente em um servidor
iSeries. Como usudrio, vocé utiliza a pagina de compras para visualizar os
produtos disponiveis e adicionar itens na cesta de compras. Quando estiver
satisfeito com os itens selecionados (no resumo da Cesta), vocé clica em um botao
de registro de saida para ser direcionado a um formuldrio de informagdes sobre o
cliente. Depois de preencher o formulario, o projeto retorna um resumo do pedido
com um botao de confirmagdo, que o leva para uma pégina de confirmagao com
seu pedido e o niimero do pedido.

Lista de produtos

D Shopping Product Quantity: I:I Size:l:l Add to basket

page information
let/JDB
Sho __ %e,\;v-%{jboxc; Product Quantity: I:I Size:l:l Add to basket
P information

para Java, SQL

(shop.html) Product Quantity: I:I Size:l:l Add to basket

information
(Viewltems.jsp)

Bean do

Servlet/
RecordlOManager
Basket Customer Order
iD summary information form summary

Link (Include tax & shipping)
Check out Link HTML— Continue - = —
HTML :
(ViewBasket.jsp) (customerinfo.html) Confirm
(ViewForConfirm.jsp)
Bean do
Servlet/Programa
de Chamada

l(D)E(:l)gr;grmation

Order number

(Confirmation.jsp)

Resumo das Etapas de Nivel Superior

Como este é um moédulo avangado, as instru¢des ndo o guiam por cada etapa de
criagdo do projeto, mas descrevem as etapas de desenvolvimento especificas do
iSeries executadas para criar esse projeto. Estas sdo as etapas de nivel superior:

1. Gravar uma pagina da Web de compras em HTML.

43



Gravar um servlet que ocupa um bean Java (utilizando JDBC e SQL) com os
itens disponiveis para compra pelo cliente.

Gravar um arquivo JSP para visualizar itens para venda e permitir que os
clientes insiram a quantidade e o tamanho do item desejado e selecionem o
item, clicando em um botdo Add to basket.

Utilizando o bean RecordIOManager, gravar um servlet chamado com o clique
no botdo Add to basket que atualiza o banco de dados INVENTORY do iSeries,
subtraindo a quantidade e o tamanho do item pedido e adicionando essa
selecdo em um bean Java denominado "basket”. Em seguida, o servlet
redireciona a resposta para ViewBasket.jsp, se a operagdo for bem-sucedida.
Caso contrario, o servlet exibe uma pagina de erro.

Gravar um formulario HTML para que o cliente insira informagdes pessoais.

Gravar um arquivo JSP da pagina de confirmagdo de compra, que mostra o
contetido da cesta, despesas de envio e impostos. A pagina também devera
conter um botdo de confirmacdo para o cliente.

Gravar um servlet que serd chamado quando o cliente clicar no botdao de
confirmagdo, que utiliza um bean Java criado com o assistente de Chamada de
programa do iSeries. Uma das chamadas de método do bean Java chama um
programa RPG para criar um novo pedido no banco de dados ORDERS no
servidor iSeries correspondente ao contetido da cesta de compras do cliente.
Em seguida, o servlet retorna um ntimero e pedido, coloca o bean Java na
sessdo do aplicativo da Web e carrega um arquivo JSP de confirmagao do
pedido, contendo o ndmero do pedido.

Antes de Comecar

E possivel concluir os exercicios somente se os pré-requisitos a seguir forem
atendidos. Os pré-requisitos estdo descritos em mais detalhes em |Capitulo 3

[‘Executando o Cenario”, na pagina 9

Vocé tem acesso TCP/IP a um servidor iSeries.
Vocé iniciou os servidores do iSeries com o comando STRTCPSVR *ALL
Vocé iniciou o servidor WebFacing com o comando STRTCPSVR *WEBFACING

Vocé restaurou as bibliotecas WHOLESALE e RETAILSTOR para o servidor
iSeries.

As bibliotecas WHOLESALE, RETAILSTOR e QGPL estdo na lista de bibliotecas.
Vocé concluiu todas as tarefas do [Capitulo 3, “Executando o Cenério”, na paginal

E (exceto as tarefas opcionais do WebSphere Application Server, que nao sao

obrigatdrias para testar o aplicativo no o Ambiente de Trabalho).

Criando a Pagina da Web, Servlets e Arquivos JSP

Para construir os componentes do projeto SV001585:

1
2

3.

. Crie um projeto da Web.

. Grave uma pégina shop.html com o Page Designer, contendo um link que
chama um servlet Getltems

Importe o arquivo jt400.jar para o iSeries Toolbox para classes Java na pasta [ib
do projeto da Web. Esse arquivo jar esta em

x:\wdsc\wssd\ plugins\com.ibm.etools.iseries.toolbox\runtime, em que x é o
diretério no qual o Development Studio Client foi instalado.

Nota: Consulte GetItems.java e ViewItems.jsp no projeto SV001585 para ver
as partes relacionadas ao iSeries Toolbox principal para Java JDBC e
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SQL para o servlet e o JSP. Na visualizagdo Navegador da perspectiva
da Web, vocé localizara GetItems.java expandindo SV001585 > source
e ViewItems.jsp, expandindo SV001585 > webApplication.

4. Grave um servlet Getltems que utiliza a iSeries Toolbox para Java JDBC e SQL
para recuperar itens de vestuario do banco de dados INVENTORY do iSeries e
que:

a. Coloque o bean ResultSet contendo o resultado da consulta SQL na sessado
b. Redirecione o pedido para ViewItems.jsp

Amostra de cédigo para GetItems.jsp:
public void init() {

// Load the IBM Toolbox for Java JDBC driver.
DriverManager.registerDriver(new com.ibm.as400.access.AS400JDBCDriver());
// Note that we have retrieved the as400 name, userid, and password from
// web.xml file using and xml parser.
as400conn =

DriverManager.getConnection(

"jdbc:as400://" + as400 + ";naming=sql;errors=full",

userid,

password) ;

dmd = as400conn.getMetaData();

}

public void service(HttpServletRequest request, HttpServletResponse response){

Statement select =
as400conn.createStatement (
ResultSet.TYPE_SCROLL_INSENSITIVE,
ResultSet.CONCUR_READ ONLY);
ResultSet rs =
select.executeQuery (
"SELECT PRODNO, PRODNAME, RPRICE, IMAGE FROM "
+ retaillLibrary
+ dmd.getCatalogSeparator()
+ inventoryFile);

HttpSession session = request.getSession(true);
session.setAttribute("resultset", rs);

response.sendRedirect ("/ViewItems.jsp");

}

5. Grave um arquivo JSP Viewltems que recupere os itens de vestuario do bean
ResultSet obtido na etapa anterior, para exibir os itens de vestuario no formato
de tabela. O arquivo JSP também deve incluir um formulario para cada item
que pode ser utilizado para selecionar o tamanho e a quantidade e adicionar o
item na cesta de compras. Vocé pode utilizar o Page Designer nas ferramentas
de desenvolvimento da Web do iSeries para gravar o JSP. Mais
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especificamente, vocé pode mostrar a pagina na visualizagao Design e
adicionar o cédigo apropriado na visualizagdo Origem. Amostra de cédigo
para ViewItems.jsp:
<l--Getting the ResultSet Object from the session--><%

int columnCount = 03

ResultSet rs = (ResultSet)session.getAttribute("resultset");
if(rs !=null)

N
\%

A
o°

rs.beforeFirst();
ResultSetMetaData rsmd = rs.getMetaData ();
columnCount = rsmd.getColumnCount ();

%>
<TABLE border="1">
<TBODY>
<TR>
<TD>Product ID</TD>
<TD>Name</TD>
<TD width="551">Price</TD>
<TD colspan="2"></TD>
</TR>
<%while (rs.next ()){
<TR>
<!l--Creating a form for this row (or this item)-->
<FORM name="myform" action="/SV001585/AddtoBasket"
onsubmit="return errorChecking(this);">

<!--Getting each column data from this row of ResultSet object-->
<!--Process data is a user defined method to modify the data for
display if needed-->
<%
for (int i = 1; i <= columnCount; ++i){
String value = rs.getString(i);
if (rs.wasNull ())
value = "<null>";
else{
if(i==1)
prodID=value;
value = processData(i,value);

}
%>
<TD><%=value%></TD>
<5
}

N

>

<!--Creating quantity input field and size drop down menue-->
<!--Note that we are using product id as the name of the field-->
<TD width="290">Quantity
<INPUT size="5" type="text" name='<%=prodID+"Q"%>' ><BR>
Size <SELECT name='<%=prodID+"S"%>'>
<OPTION value="s" selected>Small</OPTION>
<OPTION value="m" selected>Medium</OPTION>
<OPTION value="1" selected>Large</OPTION>
<OPTION value="XL" selected>Extra Large</OPTION>
<OPTION value="XXL" selected>Extra Extra Large</OPTION>
</SELECT>
</TD>
<TD><INPUT type="image" name="submit"
src="images/Add_to_basket.gif"></TD>
</FORM>
</TR>

<%
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>
</TBODY>
</TABLE>
<%

}

6. Importe o arquivo iseriesutjar das ferramentas de desenvolvimento Java do
iSeries para a pasta lib do projeto da Web. Esse arquivo JAR esta em
x:\wdsc\wssd \plugins\com.ibm.etools.iseries.toolbox\runtime, em que x é o
diretério no qual o produto foi instalado. Consulte AddtoBasket.java e
ViewBasket.jsp no projeto SV001585 para ver a implementacdo. Na
visualizacdo Navegador da perspectiva da Web, vocé localizara
AddtoBasket.java expandindo SV001585 > source e ViewBasket.jsp
expandindo SV001585 > webApplication.

7. Utilize o bean RecordIOManager das ferramentas de desenvolvimento Java do
iSeries para gravar um servlet AddtoBasket chamado pelo botdo Add to
basket, que atualiza o banco de dados INVENTORY do iSeries, subtraindo a
quantidade do pedido do cliente e adicionando os itens em um bean Java de
Cesta na sessdo. Amostra de codigo AddtoBasket.jsp:

public class AddtoBasket extends HttpServiet {

//Inner class of AddtoBasket
public class MyRecordIOManager extends RecordIOManager {

public MyRecordIOManager (

String hostInfol,

String hostInfo2,

String hostInfo3,

String file,

String 1ib)throws Exception{
super(hostInfol, hostInfo2,hostInfo3,file,1ib);
setFileAccessType(RecordIOManager.FILEACCESS_KEYED);
setCommitLockLevel (RecordIOManager.COMMITLOCKLEVEL ALL);
//journal has the same name as the database file
setJournal(file);
//journal is in the same library as the database file
setJournalLibrary(1ib);

public synchronized String updateDBFile(
String id,

String size,

String quantity

)

//opening the file
try {
if (openFile()) {
record = readRecord(key);
quantityAvailable = ((BigDecimal)
record.getValueAt(0,sizeColumn)).intValue();
totalQuantityAvailable = ((BigDecimal)
record.getValueAt (0, 8)).intValue();
if (quantityRequested <= quantityAvailable) {
newQuantity =
new BigDecimal(quantityAvailable - quantityRequested);
totalNewQuantity =
new BigDecimal
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(totalQuantityAvailable - quantityRequested);
record.setValueAt (newQuantity, 0, sizeColumn);
record.setValueAt(totalNewQuantity, 0, 8);

// Note that we update the record but we don't commit
// in case the customer decides to
// empty the basket in which
// case we call the rollBack method
updateRecord(record) ;
status = success;
} else {
status = notEnough;
}
} else
status = accessError;
} catch (Exception e) {
e.printStackTrace();
status = accessError;

}

//closing the file and adding
try {
closeFile();
} catch (Exception e) {
//in case of error rollback
try {
rollback();
} catch (Exception el) {
el.printStackTrace();
1
status = accessError;

}

return status;
}
}

//init method of AddtoBasket servlet
public void init() {
hostInfo = GetItems.getHostInfo();

}

public void doGet(HttpServletRequest req,
HttpServletResponse res) {

Basket basket = (Basket) session.getAttribute("basket");
MyRecordIOManager recIO =
(MyRecordIOManager) session.getAttribute("recIO");
if (basket == null) {
basket = new Basket();
session.setAttribute("basket", basket);

}

if(recI0 == null){
if (recIO == null) {
try {
recl0 =
new MyRecordIOManager(
hostInfo[0],
hostInfo[1],
hostInfo[2],
GetItems.getInventoryFile(),
GetItems.getRetailLibrary());
} catch (Exception e) {
try {
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res.sendRedirect ("errorPage.html");
return;
} catch (Exception el) {
el.printStackTrace();
1
1
}
id = req.getParameter("id");
size = req.getParameter(id + "S");
quantity = req.getParameter(id + "Q");

status = recIO.updateDBFile(id, size, quantity);
session.setAttribute("recIO", recl0);

if (status.equals("SUCCESS")) {
basket.addItem(id, quantity, size);
try {
res.sendRedirect ("ViewBasket.jsp");
return;
} catch (Exception e) {
e.printStackTrace();

}

} else {

if (status.equals("NOT_ENOUGH")) {
try {
res.sendRedirect("insufficient.html");
return;

} catch (Exception e) {
e.printStackTrace();

}

} else
if (status.equals("ACCESS_ERROR")) {
try {
res.sendRedirect ("errorPage.html");
return;
} catch (Exception e) {
e.printStackTrace();
}
1

}

8. Grave um arquivo JSP ViewBasket que exiba o contetido da cesta.

9. Grave um formulario customerinfo.html para a entrada de informacdes sobre
pagamento, incluindo um botdo Continue que chama ViewForConfirm.jsp.

10. Grave um ViewForConfirm.jsp que mostre o conteido da cesta inteira, mais o
saldo atual. O ViewForConfirm.jsp pode ser desenvolvido da mesma forma
que ViewBasket.jsp, com a adi¢do de um encargo para envio calculado e um
botdo Confirm que coloca um pedido no banco de dados ORDERS do iSeries.

11. Utilize o assistente de Chamada de Programa do iSeries das ferramentas de
desenvolvimento Java do iSeries para criar um bean PLACEORD.java, que
acessa o programa de servico PLACEODR na biblioteca RETAILSTOR. O
assistente cria beans para uso por aplicativos Java ou pelo assistente Servicos
da Web para acessar programas ILE do iSeries.

a. Para abrir o assistente, clique com o botdo direito do mouse em SV001585
na visualizagdo Navegador e selecione New > Other.
Na janela New, clique em iSeries > Java > Program Call Bean.
No assistente de Chamada de Programa, insira informagdes sobre o nome

do programa ILE do iSeries, biblioteca, tipo de programa e pardmetros de
entrada e saida.

Capitulo 6. Médulo Avancado 1: Criar HTML, Servlets e Arquivos JSP que Fazem Pedidos do Cliente em um Servidor iSeries
(Sv001585) 49



d. A dltima janela do assistente fornece a opgao de criar um bean para um
aplicativo Java, um servigo da Web ou ambos. Neste projeto, basta criar
um para o aplicativo Java.

Nota: O programa de servigos PLACEODR obtém uma matriz de estruturas e
coloca cada elemento de um registro de um banco de dados ORDERS,
gerando o nimero do pedido como saida para cada matriz.

12. Grave um servlet PlaceOrder chamado pelo botao ViewForConfirm.jsp
Confirm.

* O servlet utiliza o bean gerado pelo assistente de Program Call do iSeries
para acessar um servidor iSeries e registrar pedidos no banco de dados
ORDERS da biblioteca RETAILSTOR.

* Os pedidos sao os itens na cesta de compras, enviados para o programa ILE
como uma matriz de estruturas.

¢ (Cada estrutura dessa matriz é um item na cesta.

* O programa de servicos PLACEORD RPG chamado pelo bean retorna o
numero do pedido e um parametro de saida e o coloca na sessao.

O segmento de coédigo a seguir mostra como o servlet PlaceOrder utiliza o
bean PLACEORD:

public void init() throws ServletException {
hostInfo = GetItems.getHostInfo();
super.init();

try {

/* creating an instance of the PLACEORD bean created
by iSeries Program Call Bean wizard */

orderBean = new PLACEORD();
orderBean.setConnectionData(hostInfo[0],
hostInfo[1], hostInfo[2]);

} catch (Exception e) {
e.printStackTrace();

}

1

public void doPost(HttpServletRequest request,
HttpServletResponse response) {

PLACEORD.Orditems_Struct inputStruct = null;

// retrieving the order items from the basket
Basket basket =
(Basket) request.getSession().getAttribute("basket");
AddtoBasket.MyRecordIOManager reclQ =
(AddtoBasket.MyRecordIOManager)
request.getSession().getAttribute("recI0");
if (basket == null || basket.size() ==
|| recI0 == null) {
try {
response.sendRedirect ("errorPage.html");
} catch (IOException e) {
e.printStackTrace();

}
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} else {

items = basket.elements();

// setting array of structure elements

while (items.hasMoreElements()) {
item = (String[]) items.nextElement();
inputStruct = orderBean.getOrdItemAr(j);
inputStruct.setItemNo(new BigDecimal (item[0]));
inputStruct.setQuantity(new BigDecimal(item[1]));
inputStruct.setSizeOrd(item[2]);
Jj=i+t 1L

1

// setting the rest of the array elements to dummy values

for (int i = j - 1; i < 100; i++) {
inputStruct = orderBean.getOrdItemAr(i);
inputStruct.setItemNo(new BigDecimal(0));
inputStruct.setQuantity(new BigDecimal(0));
inputStruct.setSizeOrd("s");

1

// setting the other two input parameters of the bean
orderBean.setNumOfItems(new BigDecimal(j));
orderBean.setBalance((BigDecimal)
request.getSession().getAttribute("balance"));

try {

// invoking the iSeries program

orderBean.invoke();

// retrieving the order number from PLACEORD bean
orderNumber = (orderBean.getRetCode()).toString();
request.getSession().setAttribute("orderNumber",
orderNumber) ;

basket.empty();

// commit this order now

recI0.commit();

response.sendRedirect ("orderNumber.jsp");

return;

} catch (Exception e) {

response.sendRedirect ("errorPage.html");
e.printStackTrace();

}

}
}

13. Grave um servlet OrderNumber que recupere o nimero e o exiba para o
cliente, junto com uma mensagem de confirmagdo. Se o cliente néo tiver
adicionado itens em sua cesta de compras, certifique-se que seja retornada
uma pagina de erro.

Capitulo 6. Médulo Avancado 1: Criar HTML, Servlets e Arquivos JSP que Fazem Pedidos do Cliente em um Servidor iSeries

(SV001585)
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Capitulo 7. Moédulo Avancado 2: Criar o Projeto da Web que
Utiliza os Servicos da Web SV000514 e SV001586 (SV000618)

Introducéo

Este projeto demonstra como utilizar seus conhecimentos em programacdo de RPG
para criar clientes da Web para o iSeries Servigos de Web e programas RPG. Neste
projeto, sua fungdo é de administrador, passando por uma série de paginas da Web
para determinar a quantidade em inventario e para fazer pedido de inventario
adicional para a loja varejista ao fornecedor atacadista. Insira o ntimero do item,
visualize os detalhes do item, indique as quantidades e tamanhos do pedido e
aceite a confirmacao.

Lista de itens

Administrator Subfile DTC
L rege
* 12345
. * 45678
Order items WIW-1—p|
(index.html)
Get details Cancel
(Listltems.jsp)
WIW-2
Detalhes v Custo de retorno
Jacket
Retail: 129.95 Serviet/Servigo Cost: 129.95
Color: Red " daWeb - 3 —>
Get cost Cancel Order
; —— WIW-4 — )
(GetCost.jsp) (ReturnedCost.jsp)

Pedido I

Confirmar
Quantity: |:|
S I | i
Order OK

(Order.jsp) (OrderOk.jsp)

(WIW = Web Interaction Wizard)

Como este é um moédulo avangado, as instrugdes ndo o guiam por cada etapa de
criagdo do projeto, mas descrevem as etapas de desenvolvimento necessarias para
criar esse projeto. O projeto utiliza os seguintes componentes do Development
Studio Client:
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ferramentas de desenvolvimento da Web do iSeries para criar as paginas da Web
com o Page Designer, incorporando a saida do assistente de Interacdo com a
Web e diversos Componentes da Web

O Remote System Explorer para criar um programa de servicos TNLSTITM RPG
que retorna informagdes sobre o item

O assistente Servigos de Web para gerar cédigo de proxy do servlet, que localiza
precos de itens e faz os pedidos

ferramentas de desenvolvimento Java do iSeries para criar os servlets necessérios

O Ambiente de Teste do WebSphere para verificar o aplicativo antes da
implementagdo no servidor iSeries através do WebSphere Application Server

Antes de Comecar

E possivel concluir os exercicios somente se os pré-requisitos a seguir forem
atendidos. Os pré-requisitos estdo descritos em mais detalhes em [Capitulo 3

[“Executando o Cendrio”, na pagina 9

Vocé tem acesso TCP/IP a um servidor iSeries.
Vocé iniciou os servidores do iSeries com o comando STRTCPSVR *ALL
Vocé iniciou o servidor WebFacing com o comando STRTCPSVR «WEBFACING

Vocé restaurou as bibliotecas WHOLESALE e RETAILSTOR para o servidor
iSeries.

As bibliotecas WHOLESALE, RETAILSTOR e QGPL estdo na lista de bibliotecas.
Vocé concluiu todas as tarefas do [Capitulo 3, “Executando o Cendrio”, na pagina)

IQ (exceto as tarefas opcionais do WebSphere Application Server, que nao sao

obrigatdrias para testar o aplicativo no o Ambiente de Trabalho).

Criando as Paginas da Web, Servlets, JSPs e Codigo RPG

Para construir os componentes do SV000618:

1. Crie um projeto da Web para conter todos os arquivos que serdo criados.

2. Grave um arquivo JSP Listltems que relacione os itens no banco de dados do

inventério do iSeries. Vocé pode utilizar o Page Designer nas ferramentas de
desenvolvimento da Web do iSeries para gravar o servlet. Mais especificamente,
vocé pode mostrar a pagina na visualizagdo Design e adicionar o codigo
apropriado na visualizacdo Origem. Também é necessario inserir um
subarquivo DTC (Design Time Control) para interagir com o programa de
servicos TNLSTITM RPG, preenchendo o subarquivo com registros do banco de
dados. Vocé pode especificar o programa de servicos nas defini¢des de controle
do DTC.

Em seguida, é necessario utilizar o assistente de Interacdo com a Web para criar a
pagina de entrada:

Especifique ListItems.jsp como pagina de saida para relacionar itens do
inventdrio, o que garante que o assistente de Interagdo com a web crie um
arquivo ListItems.wit.

Certifique-se de ndo especificar chamadas de programa no assistente de
Interagdo com a Web, ja que o subarquivo DTC chama automaticamente o
programa de servicos TNLSTITM RPG. O assistente também gera um
ListltemsWitServlet que age como um link para chamar a pagina ListItems.jsp.

Para rever o arquivo ListItemsWit.wit gerado pelo assistente de Interagao com
a Web:
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1. Expanda SV001618 e dé um clique duplo em Listltems.wit para exibir o
assistente de interacdo do arquivo.

2. Clique em Next no assistente para revisar os valores especificados para a
interacgao.

Em seguida, é necessario gravar uma pégina de saida JSP GetCost com o Page
Designer, que utiliza a entrada da pagina ListItems.jsp. Quando um usuadrio clica
em um item na péagina Listltems.jsp, uma pagina GetCost.jsp exibe detalhes do
item.

Depois de criar a pagina GetCost.jsp, utilize o assistente de Interacdo com a Web
para criar uma interacdo WitOrder entre ListItems.jsp (selecionado como pégina
de entrada) e GetCost.jsp (selecionado como pagina de saida):

* Na pégina Chamada de Programa do assistente, especifique uma chamada do
procedimento GetDetail e parametros do programa de servigos TNLSTITM RPG.

* No procedimento, as APIs do subarquivo DTC sédo incorporadas para determinar
qual registro do subarquivo foi selecionado. O procedimento utiliza essas
informagdes para recuperar o registro selecionado do banco de dados
INVENTORY e exibe detalhes, inclusive a imagem, do item selecionado em
GetCost.jsp.

* Para rever o arquivo WitOrderWit.wit gerado pelo assistente de Interacdo com a
Web:

1. Expanda SV001618 e dé um clique duplo em WitOrder.wit para exibir o
assistente de interacdo do arquivo.

2. Clique em Next no assistente para revisar os valores especificados para a
interacgao.

Observe que o parametro flow é especificado como controlador de fluxo na
pagina de saida. Isto faz com que o valor do parametros assegure que os
arquivos JSP apropriados sejam exibidos.

Em seguida, é necessério importar arquivos WSDL (Web Services Definition
Language) do projeto SV000514, para que o administrador possa recuperar o custo
atual de um item do fornecedor atacadista, pressionando o botdo Get cost.

* O botao Get cost chama QryProdCostServlet.jsp e o servico da Web
correspondente do projeto SV000514.

* Utilize o assistente de Servigos da Web e os arquivos WSDL importados para
gerar o c6digo proxy Java necessério para chamar o servico da Web.

* O QryProdCostServlet.jsp obtém a entrada da pagina GetCost.jsp, utiliza o
cédigo proxy Java para chamar o servigo da Web SV000514 para localizar o
custo do item selecionado e exibe o custo em uma pagina denominada
ReturnedCost.jsp.

* Para visualizar o c6digo QryProdCostServicesProxy.java e
QryProdCostServiet.java:

1. Expanda SV001618 > source > proxy > soap.
2. Dé um clique duplo em QryProdCostServicesProxy.java.

3. No QryProdCostServiet.java, dé um clique duplo em
QryProdCostServlet.java, em SV001618 > source e observe como ele
instancia o cédigo proxy Java.
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Em seguida, é necessario utilizar o assistente de Interagdo para a Web para
vincular ReturnCost.jsp como entrada e Order.jsp como saida, para que o
administrador possa clicar em um botao Order para pedir o item selecionado para
o fornecedor atacadista.

* Com essa interagdo, ndo € necessario utilizar uma chamada de programa, pois o
vinculo das duas paginas € suficiente para exibir as informagdes corretas.

* Para visualizar WitPlaceOrder.wit:
1. Expanda SV001618.
2. Dé um clique duplo em WitPlaceOrder.wit para abrir a interagéo.

3. Clique em Next no assistente para revisar os valores especificados.

Em seguida, utilize o servico da Web SV001586 para que o administrador possa
especificar o tamanho e a quantidade dos itens pedidos.

* Importe os arquivos WSDL SV001586 para este projeto, gere cddigo proxy Java
para chamar o servico da Web e grave um OrderSupplyServlet chamado quando
0 usudrio pressiona o botdo Order em Order. jsp.

* O servlet retine informagdes de Order. jsp, chama o cédigo proxy Java do
servico da Web, que chama o servigco da Web SV001586 e faz o pedido do item.

e O servlet exibe Order0OK. jsp se o pedido for bem sucedido. Caso contrario, exibe
uma pégina de erro.

* Para ver como o proxy do servico da Web gerado € instanciado e chamado para
utilizar o servico da Web SV001586:

1. Expanda SV000618 > source.

2. Dé um clique duplo em OrderSupplyServlet.java e verifique o contetdo.

Antes de Implementar no WebSphere Application Server

Antes de implementar o aplicativo no WebSphere Application Server, é necessario
alterar um URL especifico dentro dos arquivos de classe Java SV000514 e SV001586
para que o aplicativo funcione corretamente.

No SV000514:

* Na classe de proxy dos servicos da Web, QryProdCostServicesProxy, é definida
uma variavel que contém o URL do servico da Web a ser chamado.

* Na primeira vez que o proxy é criado, esse URL é definido como
http:/ /localhost:9080/SV000514 /servlet/rpcrouter.

* Com a variavel definida com esse valor, o servico da Web no projeto SV000514
no IDE é chamado, como demonstrado em [“Executando o Aplicativo no|
[Workbench” na pagina 17}

* Antes de implementar este aplicativo, é necessario alterar esse valor de URL
para que indique o local no qual o arquivo EAR foi implementado,
SVWholeSale.ear, no diretério IFS do iSeries.

No projeto SV001586:

* Na classe de proxy dos servigos da Web, OrderSupplyServicesProxy, é definida
uma variavel que contém o URL do servico da Web a ser chamado.

* Na primeira vez que o proxy é criado, esse URL é definido como
http:/ /localhost:9080/SV001586 /servlet/rpcrouter.

* Com a variavel definida com esse valor, o servico da Web no projeto SV001586
no IDE é chamado, como demonstrado em [‘Executando o Aplicativo noj
[Workbench” na pagina 17}
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* Antes de implementar este aplicativo, é necessdrio alterar esse valor de URL
para que indique o local no qual o arquivo SVWholeSaleEAR.ear foi
implementado no diretério IFS do iSeries.
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Capitulo 8. Avisos

Nota sobre Direitos Restritos para Usuarios do Governo dos Estados Unidos - Uso,
duplicagdo e divulgacao restritos pelo documento GSA ADP Schedule Contract
com a IBM Corporation.

Estas informagdes foram desenvolvidas para produtos e servigos oferecidos nos
Estados Unidos. E possivel que a IBM nao oferega os produtos, servicos ou
recursos discutidos nesta publicagdo em outros paises. Consulte o representante
IBM local para obter informagdes sobre produtos e servicos atualmente disponiveis
em sua area. Qualquer referéncia a produtos, programas ou servicos IBM nado
significa que apenas produtos, programas ou servi¢cos IBM possam ser utilizados.
Qualquer produto, programa ou servigo funcionalmente equivalente, que nado
infrinja nenhum direito de propriedade intelectual da IBM, poderd ser utilizado em
substituicdo a este produto, programa ou servico. Entretanto, a avaliacao e
verificacdo da operagdo de qualquer produto, programa ou servi¢co nao-IBM sio de
inteira responsabilidade do Cliente.

A IBM pode ter patentes ou solicitagdes de patentes pendentes relativas a assuntos
tratados nesta publicacdo. O fornecimento desta publicagdo ndo garante ao Cliente
nenhum direito sobre tais patentes. Pedidos de licenca devem ser enviados, por
escrito, a:

Geréncia de Relagoes Comerciais e Industriais da IBM Brasil. Av. Pasteur, 138-146,
Botafogo, Rio de Janeiro, R], CEP 22290-240.

Para pedidos de licenga relacionados a informacgoes de DBCS (Conjunto de
Caracteres de Byte Duplo), entre em contato com o Departamento de Propriedade
Intelectual da IBM em seu pais ou envie pedidos de licenga, por escrito, para:

IBM World Trade Asia Corporation Licensing 2-31 Roppongi 3-chome, Minato-ku

O pardgrafo a seguir nao se aplica a nenhum pais em que tais disposi¢des nao
estejam de acordo com a legislacao local: A INTERNATIONAL BUSINESS
MACHINES CORPORATION FORNECE ESTA PUBLICACAO "NO ESTADO EM
QUE SE ENCONTRA"” SEM GARANTIA DE NENHUM TIPO, SEJA EXPRESSA
OU IMPLICITA, INCLUINDO, MAS NAO SE LIMITANDO AS GARANTIAS OU
CONDICOES DE NAO-VIOLACAO, MERCADO OU ADEQUACAO A UM
DETERMINADO PROPOSITO. Alguns paises ndo permitem a exclusdo de
garantias expressas ou implicitas em certas transac¢des; portanto, esta disposi¢do
pode ndo se aplicar ao Cliente.

Esta publicacdo pode incluir imprecisdes técnicas ou erros tipograficos.
Periodicamente, sdo feitas altera¢des nas informagdes aqui contidas; tais alteragdes
serdo incorporadas em futuras edi¢des desta publicacdo. A IBM pode, a qualquer
momento, aperfeicoar e/ou alterar os produtos e/ou programas descritos nesta
publicacgdo, sem aviso prévio.

Referéncias nestas informagdes a Web sites ndo-IBM sdo fornecidas apenas por
conveniéncia e ndo representam de forma alguma um endosso a esses Web sites.
Os materiais contidos nesses Web sites ndo fazem parte dos materiais deste
produto IBM e a utilizagdo desses Web sites é de inteira responsabilidade do
Cliente.
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A IBM pode utilizar ou distribuir as informagdes fornecidas da forma que julgar
apropriada sem incorrer em qualquer obrigagdo para com o Cliente.

Licenciados deste programa que desejam obter informagdes sobre este assunto com
o objetivo de permitir: (i) a troca de informacdes entre programas criados
independentemente e outros programas (incluindo este) e (ii) a utilizagdo mutua
das informacoes trocadas, devem entrar em contato com:

Geréncia de Relacoes Comerciais e Industriais da IBM Brasil. Av. Pasteur, 138-146,
Botafogo, Rio de Janeiro, R], CEP 22290-240.

Tais informagdes podem estar disponiveis, sujeitas a termos e condi¢des
apropriadas, incluindo em alguns casos o pagamento de uma taxa.

O programa licenciado descrito neste documento e todo o material licenciado
disponivel sdo fornecidos pela IBM sob os termos do Contrato com o Cliente IBM,
do Contrato de Licenca do Programa Internacional IBM ou de qualquer outro
contrato equivalente.

As informacoes relativas a produtos ndo-IBM foram obtidas junto aos fornecedores
dos respectivos produtos, de seus antincios publicados ou outras fontes disponiveis
publicamente. A IBM ndo testou esses produtos e ndo pode confirmar a exatidao
de seu desempenho, compatibilidade nem qualquer outra reivindicagdo relacionada
a produtos ndo-IBM. Dividas sobre os recursos de produtos nao-IBM devem ser
encaminhadas diretamente a seus respectivos fornecedores.

Essas informagdes contém exemplos dos dados e relatérios utilizados nas
operagdes comerciais didrias de negocios. Para ilustra-los da forma mais completa
possivel, os exemplos podem incluir nomes de individuos, empresas, marcas e
produtos. Todos estes nomes sao ficticios e qualquer semelhanca com nomes e
enderecos utilizados por uma empresa real é mera coincidéncia.

LICENCA DE COPYRIGHT:

Essas informagdes contém programas de aplicativos de exemplo na linguagem
fonte, ilustrando as técnicas de programagdo em diversas plataformas operacionais.
Vocé pode copiar, modificar e distribuir esses programas de exemplo sem
necessidade de pagar a IBM, com o objetivo de desenvolvimento, utilizacao,
marketing ou distribuicdo de programas aplicativos em conformidade com a
interface de programacao de aplicativo da plataforma operacional para a qual os
programas de exemplo sdo criados. Esses exemplos nado foram testados
completamente em todas as condi¢ées. Portanto, a IBM ndo pode garantir ou
implicar a confiabilidade, a manutencdo ou a fun¢do desses programas. Vocé pode
copiar, modificar e distribuir esses programas de exemplo de qualquer maneira,
sem pagamento a IBM, com o objetivo de desenvolvimento, utilizacdo, marketing
ou distribuicdo de programas aplicativos em conformidade com interfaces de
programacao de aplicativos da IBM.

Cada copia ou qualquer parte desses programas de exemplo ou qualquer trabalho
derivado deve incluir um aviso de copyright, com os dizeres:

(C) (nome da empresa) (ano). Partes desse c6digo sdo derivados dos Programas de

Exemplo da IBM Corp. (C) Copyright IBM Corp. 1992, 2002. Todos os direitos
reservados.
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Informagdes sobre a Interface de Programacgéo

As informagoes sobre a interface de programacao destinam-se a facilitar a criagdo
de software aplicativo utilizando este programa.

As interfaces de programacédo de uso geral permitem que o cliente desenvolva um
software aplicativo que obtém os servicos das ferramentas deste programa.

No entanto, essas informagdes também podem conter informagdes sobre
diagndsticos, modificagdes e ajustes. As informagdes de diagnésticos, modificacdes
e ajustes sdo fornecidas para ajudé-lo a depurar seu software aplicativo.

Aviso: Nao utilize estas informagdes sobre diagnoésticos, modificagdes e ajustes
como uma interface de programacdo, pois elas estdo sujeitas a alteragdes.

Marcas Comerciais e Marcas de Servico

* 400 * CUA * OS/390

* AFP » DB2 * 05/400

* AIX * DB2 Extenders * POWER2

* AIX windows * DB2 Universal Database * PowerPC

¢ APPN - SPTVET * PROFS

* Application System/400 * GbDM * RPG/400

* AS/400 * IBM * RS/6000

* AS/400e » IBMLink *5/390

* BookManager * Integrated Language * SAA
Environment

* C Set ++ * iSeries * SQL/400

» C/400 * Language Environment * System/36

* CICs * MQSeries * System/38

* CICS/400 * Network Station * VisualAge

* CICS/ESA * Open Class * VTAM

* COBOL/2 * Operating System/2 * WebSphere

* COBOL/400 * Operating System/400

* Common User Access * 0S/2

InstallShield é uma marca comercial da InstallShield Corporation.

Intel e Pentium sdo marcas comerciais da Intel Corporation nos Estados Unidos
e/ou em outros paises.

Java e todas as marcas comerciais e logotipos baseados em Java sdo marcas
comerciais ou marcas registradas da Sun Microsystems, Inc., nos Estados Unidos

e/ou em outros paises.

Rational é uma marca comercial da International Business Machines Corporation e
Rational Software Corporation nos Estados Unidos e/ou em outros paises.
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Lotus, Lotus Notes e Domino sao marcas comerciais da Lotus Development
Corporation nos Estados Unidos e/ou em outros paises.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT, Win32, Win32s e o logotipo Windows sdo marcas comerciais da Microsoft
Corporation nos Estados Unidos e/ou em outros paises.

Netscape Navigator é uma marca da Netscape Communications Corporation.

UNIX é uma marca registrada do The Open Group.

Outros nomes de empresas, produtos e servigos podem ser marcas comerciais ou
marcas de servi¢o de terceiros.
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